
FUNDAMENTALS OF COMPUTER-7BSOA1 

UNIT-I 

 COMPUTER: DEFINITION,  

 CHARACTERSTICS OF COMPONENTS, 

 BASIC APPLICATION OF COMPUTERS.  

 COMPONENTS OF COMPUTER SYSTEM: CENTRAL PROCESSING UNIT (CPU), 

 INPUT/OUTPUT DEVICES,  

 COMPUTER MEMORY: PRIMARY AND SECONDARY MEMORY, 

 MAGNETC AND OPTICAL STORAGE DEVICES,  

 CONCEPTS OF HARDWARE AND SOFTWARE. 

 1.1 DEFINITION OF COMPUTER 

Computer is an  electronic device that takes input data from the user and processes these 

data under the control of set of instructions (program) and gives the desired result as output and 

may saves output for the future use. 

 

Functions of Computer 
1. Accepts data (Input).    2. Processes data (Processing).  

3. Produces result (Output).   4. stores results (Storage)  

 
1.2 CHARACTERISTICS OF COMPUTERS 

Computer has the following characteristics 

 Accuracy 

 Diligence 

 Versatility 

 Reliability 

 Automation 

 Storage 
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Speed 

 A computer works with much higher speed compared to humans  

 Computers can process millions of instructions per second.  

 The time taken by computers for their operations is microseconds and nanoseconds. 

Accuracy 

 Computers perform calculations with 100% accuracy.  

 Errors that may occur can almost always be attributed to human error. 

 Inaccurate data, poorly designed system or faulty programs written by the programmer 

Diligence 

 Computers are highly consistent.  

 They do not suffer from human traits of boredom and tiredness, lack of concentration.  

 Computers can perform voluminous and repetitive jobs. 

Versatility 

 Computers are versatile machines and are capable of performing any task as long as it 

can be broken down into a series of logical steps. 

 Computer to perform different kinds of works with same accuracy and efficiency. 

Reliability 

 A computer is reliable as it gives consistent result for similar set of data 

  we give same set of input any number of times, we will get the same result. 

Automation 

 Computer performs all the tasks automatically.It performs tasks without manual 

intervention. 



Memory/Storage 

 Computers can store large volumes of data.  

 A piece of information once recorded (or stored) in the computer, can never be forgotten 

and can be retrieved almost instantaneously. 

1.3 APPLICATION OF COMPUTER 

The computer used in various application area  inthe world. 

 

1. Business 

2. Education 

3. Marketing 

4. Banking 

5. Insurance 

6. Communication 

7. Health Care 

8. Military 

9. Engineering Design 

 

› Business 

A computer has an integrated part in all business or non-business organizations. 

Ex: Payroll calculations, Sales analysis, Budgeting, Financial forecasting, Managing employees 

database and Maintenance of stocks etc. 

 

› Education 

Computers have its dominant use in the education field to enhance performance in learning.  

Even distance learning is made effective through internet and video-based classes. 

Researchers have massive usage of these computers in their scholarly work. 

 

› Marketing 

Advertising marketing with computers, advertising professionals create art and graphics, write 

and revise copy, and print and disseminate ads with the goal of selling more products. 

 

Computerized catalogues that provide access to product information and permit direct entry of 

orders to be filled by the customers. the computer used to prints the  magazines, , newspapers, 

books and many others. 

 

› Banking 

Today banking is almost totally dependent on computer. Banks provide online accounting 

facility, which includes current balances, deposits, overdrafts, interest charges, shares, and 

trustee records. 

ATM machines are making it even easier for customers to deal with banks. 

 

› Insurance 

Insurance companies are keeping all records up-to-date with the help of computers. The 

insurance companies, finance houses and stock broking firms are widely using computers for 

their concerns. 



 

› Communication 

Communication means to convey a message, an idea, a picture or speech that is received and 

understood clearly and correctly by the person for whom it is meant for. Some main areas in this 

category are: Chatting, E-mail, Usenet, FTP, Video-conferencing and Telnet. 

 

› Health Care 

Most of the medical information can now be digitized from the prescription to reports. 

Computation in the field of medicine allows us tooffer varied miraculous therapies to the 

patients. software used to examine the internal organs of the human body.  ECG’s, radiotherapy 

done with the help of computers. 

 

› Military 

Computer builds the links between the soldiers and commanders through the satellite. 

Construction of weapons and controlling their function is not possible without the aid of 

computers. The list of the criminals and the records of the cops are maintained regularly in the 

system. 

 

› Engineering Design 

computers aid in designing buildings, automobiles, electrical and electronics. The construction 

layouts are designed beautifully on system using different tools and software’s.  

 

1.4 GENERATION OF COMPUTER  

The history of the computer goes back several decades. CharlesBabbage is known as father of 

computer he has invented first analytical computer in year 1822.however, and there are five 

definable generations of computers.Each generation is defined by a significant technological 

development that changes fundamentally how computers operate – leading to more compact, less 

expensive, but more powerful, efficient and robust machines. 

 

1. First Generation (1946 - 1959) 

2. Second Generation (1959 - 1965) 

3. Third Generation (1965 - 1971) 

4. Fourth Generation (1971 - 1980) 

5. Fifth Generation (1980 onwards) 

 

FIRST GENERATION- Vacuum Tubes(1946-1959) 

1. These early computers used vacuum tubes as circuitry and magnetic drums for memory.  

2. These computers relied on ‘machine language. 

3. These computers could calculate in milliseconds. 

4. The two notable machines of this era were the UNIVAC and ENIAC machines  

5. These were very big in size, costly.Need a cooling system. 

SECOND GENERATION-Transistors1959-1965 
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1. Due to the presence of transistors instead of vacuum tubes,. 

2.  This reducing the size of a computer. 

3. Assembly language and punch cards were used for input. 

4. Better speed, portability. calculate data in microseconds. 

5. A cooling system, Constant maintenance was required. 

THIRD GENERATION– Integrated Circuits1965-1971 

1. the transistors were now being miniaturized and put on silicon chips (called 

semiconductors). 

2. These computers were cheaper as compared to second-generation computers. 

3. they were fast and reliable. small size of the computer big storage capacity. 

4. IC not only reduce the size of the computer but it also improves the performance of the 

computer as compared to previous computers. 

5. Instead of punch cards, mouse and keyboard are used for input. 

6. They used an operating system for better resource management and used the concept of 

time-sharing and multiple programming. 

7. These computers reduce the computational time from microseconds to nanoseconds. 

8. IC chips are difficult to maintain. Air conditioning is required. 

FOURTH GENERATIONMicroprocessors1971-1980. 

1. Fastest in computation and size get reduced as compared to the previous generation of 

computer. 

2. Small in size as compared to previous generation computers. 

3. Less maintenance is required. 

4. All types of high-level language can be used in this type of computers. 

5. The Microprocessor design and fabrication are very complex. 

6. Air conditioning is required in many cases due to the presence of ICs. 

FIFTH GENERATIONArtificial Intelligence1980-onwards 

1. Computer devices with artificial intelligence are still in development, 

2. AI is a reality made possible by using parallel processing and superconductors. It is 

support voice recognition. quantum computation, molecular and nano technology. 

3. Which can process and respond to natural language, and have capability to learn and 

organise themselves. 

4. this generation is based on ULSI(Ultra Large Scale Integration) technology resulting in 

the production of microprocessor chips having ten million electronic component 

5. It is more reliable and works faster. 

6. It is available in different sizes and unique features. 

7. It provides computers with more user-friendly interfaces with multimedia features. 

1.5 TYPES OF COMPUTER 

Computers vary widely in terms of their size and purpose they serve. There are very small 

computers that can be held on a palm. There are also large computers that take a whole room to 

occupy.  



 

1. Micro Computer 

2. Mini Computer 

3. Mainframe Computer 

4. Super computer 

5. Workstations 

 

 

» Micro Computer 
Microcomputer is at the lowest end of the computer range in terms of speed and storage capacity. 

Its CPU is a microprocessor. The first microcomputers were built of 8-bit microprocessor chips. 

The most common application of personal computers (PC) is in this category. The PC supports a 

number of input and output devices. 

Microcomputers include (a) portable computers and (b) desktop computers. 

(a) Portable Computer 
Portable computer is a very small, easy to use microcomputer. The users can carry it wherever 

they go. This group includes personal digital assistant, pen-based computer, hand-held computer, 

notebook computer and laptop computer. 

(b) Personal Computer or Desktop Computer 
Personal computer is a microprocessor based, single user computer. The peripherals for personal 

computer include a keyboard and a mouse as input devices, monitor to display information and a 

hard disk for storage. 

 

 
 

 

 

» Mini Computer 
Minicomputer is a medium sized computer that is costlier and more powerful than a 

microcomputer. It is in fact a scaled down version of mainframe computer. This can support up 

to a few hundred users at a time with multi-terminal, time-sharing system. They are mainly used 

as departmental computers in large and medium-sized organisations. They are also used in 

government departments, universities and R and D establishments. 



 

 
 

» Mainframe Computer 
The earliest computers were callpd mainframes due to their size. The term is still used for the 

large computers of today. They have large storage capacities, very high speed of processing 

(compared to micros and minis) and can support a large number of terminals (Many hundreds to 

thousands) for use by a variety of users simultaneously. They are kept in air-conditioned 

environment in a special computer room. They are used by big companies, banks, government 

departments, etc. as their main computer. 

 

 
 

 

 

» Super computer 

It is the fastest and the most expensive computer. This has extremely large storage capacities and 

computing speeds that are at least ten times faster than that of other computers. It can perform 

hundreds of millions of instructions per second. The super computer is used for specialised 

applications such as large-scale numerical problems in scientific and engineering disciplines. 

These include applications in electronics, petroleum engineering, weather forecasting, medicine 

and nuclear energy research. 



 

 
 

» Workstations 

Workstation is a powerful computer which in terms of power is between personal computer and 

minicomputer. It has high resolution graphics monitor, large RAM and secondary storage. 

Although it is a standalone system, usually it forms part of a network and it uses Unix or 

Windows NT as operating system. Workstations are used for specialized applications such as 

desktop publishing, software development and engineering designs. 

 

 
 

 

1.6 COMPONENTS OF COMPUTER SYSTEM 

The computer hasthree parts. 

1. Input Unit 

2. Central Processing Unit (CPU) 

3. Output Unit 
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Any digital computer carries out five functions. 

 

1. Takes data as input. (Input) 

2. Stores the data/instructions in its memory and use them when required. ( Memory Unit ) 

3. Processes the data and converts it into useful information. ( ALU ) 

4. Controls all the above four steps (Control Unit) 

5. Generates the output (Output) 

 

› InputUnit 
This unit contains devices with the help of which we enter data into computer. This unit makes 

link between user and computer. An Input device accept data and instructions from the user and 

convert information or data in to a form which can be understood by the computer. 

 

Central Processing Unit (CPU) 
CPU is considered as the brain of the computer. CPU performs all types of data processing 

operations. It stores data, intermediate results and instructions(program).It controls the operation 

of all parts of computer. 

 

CPU  has following three components 

 ALU(Arithmetic Logic Unit) 

 Memory Unit 

 Control Unit 

 

 ALU( Arithmetic Logic Unit ) 

Function of arithmetic section is to perform arithmetic operations like addition, subtraction, 

multiplication and division and logical section perform logic operations such as comparing, 

selecting, matching and merging of data. The major operations performed by the ALU . 

 Memory Unit 
This unit can store instructions, data and intermediate results. This unit supplies information to 

the other units of the computer when needed.  

 Control Unit: 

The process of input, output, processing and storage is performed under the supervision of a unit 

called 'Control Unit'. It decides when to start receiving data, when to stop it, where to store data, 

etc. It takes care of step -by-step processing of all operations inside the computer. 
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› Output unit 
This is the process of producing results from the data for getting useful information. 

 

1.7 INPUT DEVICES 
This unit contains devices with the help of which we enter data into computer. This unit makes 

link between user and computer. An Input device accept data and instructions from the user and 

convert information or data in to a form which can be understood by the computer. 

 

Important input devices 

1. Keyboard 

2. Mouse 

3. Light Pen 

4. Trackball 

5. Joystick 

6. Scanners 

7. Optical Mark Reader 

8. Optical Character Reader 

9. Barcode Reader 

10. Magnetic Ink Character Recognition 

11. Voice Recognition Systems 

12. Digital Cameras 

 

 

Keyboard 
Keyboard is the most popular input device for direct entry of data and instructions into 

computer.The computer keyboard is very much like the electronic typewriter keyboard. But it 

has additional keys. now keyboards with 104 keys or 108 keys are also available for Windows 

and internet. 

 

 

 

 

keyboard has following types of keys : 

1. Typing Keys- digit keys (0-9) and letter keys (A-Z). 

2. Numeric Keypad- set of 17 keys  

3. Function Keys- The twelve function keys 

4. Control Keys-These keys provide cursor and screen control. It includes four directional arrow 

keys. Control keys also include Home, End, Insert, Delete, Page Up, Page Down, Control(Ctrl), 

Alternate(Alt), Escape(Esc). 

5. Special Purpose Keys- Enter, Shift, Caps Lock, Num Lock, Space bar, Tab, and Print Screen. 
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Mouse 
A mouse is a small hand-held 'point and click' device that is connected to the CPU through a 

cable. Douglas Engelbart invented mouse in 1963 at Stanford Research Institute. Xerox 

Corporation's Palo Alto Research Center enhanced its capabilities by adding analogue to digital 

conversion..It rolls on a small ball and has two or three buttons on the top. When you roll the 

mouse across a flat surface the screen censors the mouse in the direction of mouse movement. 

The cursor moves very fast with mouse giving you more freedom to work in any direction. It is 

easier and faster to move through a mouse. 

 

There are three types of mouse: 

1. Mechanical Mouse 

2. Optomechanical Mouse 

3. Optical Mouse 

 

 
 

 

1. Mechanical Mouse 

Mechanical Mouse has a trackball at its bottom. It can be rolled across a flat and smooth 

surface to control the position of the cursor on the screen. By pointing and clicking on icons 

and menu options displayed on the screen, it is easy for the user to control the computer with 

a mouse. Mechanical sensors within the mouse detect the direction the ball is rolling and 

move the screen pointer accordingly. 

 

2.Optomechanical Mouse 
The Optomechanical mouse is more or less the same as the mechanical mouse, but it uses 

optical sensors to detect motion of the ball. 

 

3.Optical Mouse 
Optical mouse uses a laser to detect the mouse movement. The mouse requires to be moved 

along a special mat with a grid so that the optical mechanism has a frame of reference. 

Optical mouse is more expensive than the other two. 

Light Pen 
Light pen consists of a stylus connected by a cable to the computer terminal. When the stylus is 

brought into contact with the screen, a dot appears there on the screen. By moving the stylus on 

the screen, lines and curves can be drawn on the screen that can be stored and used as input. 

An Light Pen utilizes a light-sensitive detector to select objects on a display screen. A light pen 

is similar to a mouse, except that with a light pen you can move the pointer and select objects on 

the display screen by directly pointing to the objects with the pen. 
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Trackball 

Trackball was originally built into the keyboard. Running a hand over the trackball made the 

cursor on the screen to move. The cursor is used to make selection from a menu displayed on 

the computer screen.In addition, you can place a trackball on any type of surface, including your 

lap. For both these reasons, trackballs are popular pointing devices for portable computers. 

 

 

Joystick 

Joystick is a small vertical stick attached to a trackball for easier mechanical movements. It is 

used mainly in game programs. 

 

 
 

 

 

Scanners 

Scanners are direct-entry input devices. As the data entry is automatic, the scanners ensure more 

accurate data entry. These scanners include optical scanners and magnetic ink character readers. 

The optical scanners use light for sensing input and they include OCR, OMR and Barcode 

reader. 

 

Optical Mark Reader 

Optical mark reader (OMR) reads the presence or absence of a mark on a paper optically. Light 

is directed on to the paper and the reflected light is analysed for the detection of a mark. If a 

mark is there on the surface of the paper, that area sends back lesser light are to the OMR. It is 
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used to read multiple choice answers in a test and the data are transferred to a computer for 

processing. 

 

 
 

Optical Character Reader 

Optical character reader (OCR) detects shape, and can identify characters. It can examine each 

character as if it were made up of a collection of minute spots. Once the whole character has 

been scanned, the pattern detected is matched against a set of patterns stored in the computer. 

The pattern that matches or nearly matches is taken to be the character read. Patterns that cannot 

be identified are rejected. It is used in mail sorting and credit card billing. 

 

Barcode Reader 

Barcode is a set of small bars of varying thickness and spacing printed on the packages of 

products, on the back coverpages of books, tags etc. The barcode reader uses an optical 

scanner to read product code and converts it into electrical pulses. The device is connected to 

a computer and the information read is passed to the computer in digital form for automatic bill 

generation and updating of files. Thus, it is a direct data entry device and there is no need for an 

operator to key in sales transaction data. 

 

 
 

 

Magnetic Ink Character Recognition 

Magnetic Ink Character Recognition (MICR) uses highly stylised character shapes printed in a 

special ink containing particles that can be magnetied. This ink induces a current in a reading 

circuit, which is proportional to the area of ink being scanned. The patterns of the varying 
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currents can be compared with and selected as bit patterns of the selected number e.g., the 

number on a cheque). The MICR reader can only identify characters. Banking industry uses this 

device for sorting of cheques. The MICR codes read from the cheques are transmitted to an 

online computer for sorting and processing automatically. 

 

Voice Recognition Systems 

A special microphone is used to capture voice as input. It converts the voice into electrical pulses 

and then into digital signals for onward transmission to a computer for processing. A voice 

recognition system is provided with digital patterns of a limited vocabulary of words and 

phrases. The system operating in a training mode learns to recognize voice patterns by 

comparing the spoken input with the stored digital patterns. After identifying the input, the voice 

system generates appropriate code for the machine to accept input and operate. Voice recognition 

systems are very useful in offices for word processing. A manager can directly dictate letters and 

notes to a word processor through a speech recognition system. Similarly, the system can accept 

oral commands and execute them. These systems are yet to become popular. 

 

 
 

 

Digital Cameras 

Digital cameras are used to capture images and they can record the images on reusable floppy 

disks. Images are used with a digitiser for input to the computer. Once the image input is stored 

in computer, the image can be used in any application. 

 

1.8 OUTPUT DEVICES 
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Output device displays result of the computer processing. A Output devices return processed data 

that is information, back to the user. 

 

Some of the commonly used output devices are : 

1. Monitor (Visual Display Unit) 

2. Printers 

3. Plotter 

4. Speakers 

 

 Monitor (Visual Display Unit ) 

Visual display units (VDUs) are television-like screens that provide the user-interface in the 

form of display of text, numbers and images. The VDUs may be monochrome or colour. The 

support of monochrome or colour and clarity of display depend on the type of video monitor and 

the video adapter installed in the microcomputer. 

Two basic types of monitors are used with microcomputers : 

1. Cathode Ray Tube (CRT) 

2. Flat panel Displays (LCD,LED) 

 

 Cathode Ray Tube (CRT) 

CRT or Cathode Ray Tube Monitor is the typical monitor that you see on a desktop computer. It 

looks a lot like a television screen, and works the same way. This type uses a large vacuum tube, 

called cathode ray tube (CRT). 

 

 Flat panel Displays (LCD,LED) 

This type of monitors are also known as flat panel monitor. Most of these employ liquid crystal 

displays (LCDs) to render images. These days LCD monitor are very popular. 
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Printer 

Printers are purely output devices. They produce hard copy output. Computer printers vary 

widely in their technologies and capabilities. They can be classified in a number of ways. First, 

they can be classified into three broad groups: character printers, line printers and page printers. 

The character printers print one character at a time. Dot matrix printer (DMP), daisy wheel 

printer, thermal printer and inkjet printer are the various types of character printers. Drum printer 

and chain printer are line printers. Laser printer and magnetic printer are page printers. 

 

Some of the most commonly used printers are : 

1. Laser Printer 

2. Ink Jet Printer 

3. Dot Matrix Printer 

4. Line Printer 

 

 Laser Printer 

A laser printer produces high quality print that one normally finds in publishing. It is extremely 

fast and quiet. Moreover, the operation of a laser printer is easy with automatic paper loading and 

no smudging or messing up of ink ribbons. The fastest laser printer can print up to 200 pages per 

minute in monochrome (black and white) and up to 100 pages per minute in colour. 

 Ink-Jet Printer 

An ink-jet printer creates an image directly on paper by spraying ink through as many as 64 tiny 

nozzles. Although the image it produces is not generally quite as sharp as the output of a laser 

printer, the quality of ink-jet images is still high. 

In general, ink-jet printer offers an excellent middle ground between dot matrix and laser printer. 

Like laser printer, an ink-jet printer is quiet and convenient, but not particularly fast. Typically, 

an ink-jet printer is more expensive than a dot-matrix printer, but costs only half as much as a 

laser printer. 

 

 Dot Matrix Printer 

The dot matrix printer was very popular at one point of time. It is a very versatile and 

inexpensive output device. In dot matrix printer the print head physically "hits" the paper 

through the ribbon and produces text (or images) by combinations of dots; hence the name dot 

matrix printer. Its speed is measured in characters per second (CPS). Although it is less 

expensive, it is louder, slower and produces lower print quality. 

 Line Printer 

A line printer is generally used with large computer systems to produce text based data 

processing reports. Line printers are high-speed printers with speeds ranging anywhere from 100 

to about 3800 lines per minute. In the past, print quality on line printers was not high. 

Developments in technology are improving the print quality on line printers. These are in the 

cost range of lacs of Rupees. 

Plotter 

A plotter is a special kind of output device that like a printer produces images on paper but does 

so in a different way. Plotters are designed to produce large drawings or images, such as 

construction plans for buildings or blueprints for mechanical objects. A plotter can be connected 

to the port normally used by a printer. 
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An array of different colored pens in a clip rack and a robotic arm is part of plotter. The 

instructions that a plotter receives from a computer consist of a color, and beginning and ending 

coordinates for a line. With that information, the plotter picks up the appropriate pen through its 

arm, positions it at the beginning coordinates drops the pen down to the surface of the paper and 

draws to the ending coordinates. Plotters draw curves by creating a sequence of very short 

straight lines. 

 

Plotters usually come in two designs : 

1. Flat Bed 

2. Drum 

 

 Flat Bed 

Plotters of small size to be kept on table with restriction of paper size. 

 

 
 

 Drum 

These plotters are of big size using rolls of paper of unlimited length. 

 

 

Speaker 

A Speakers are another type of output device which allow you to listen to voice like music and 

conversation with people. 

 

 

http://generalnote.com/Basic-computer/Plotter.php
http://generalnote.com/Basic-computer/Plotter.php
http://generalnote.com/Basic-computer/Output-Devices.php


1.9 COMPUTER MEMORY 

A computer memory is just like a human brain. It is used to store data and instructions. 

Computer memory is the storage space in computer where data is to be processed and 

instructions required for processing are stored. memory is divided into large number of small 

parts called cells. Each location or cell has a unique address which varies from zero to memory 

size minus one. 

 

Computer storage can be divided into primary memory, secondary memory and cache memory. 

Primary memory or main memory in the computer provides fast access memory. The processor 

can access it directly for data and instructions. Frequently used files and programs are stored in 

the primary memory. Since primary storage is expensive, only a limited amount can be stored 

therein. Cache memory is another memory device. CPU can access it much faster than main 

memory. But it is very expensive. The secondary memory is used for bulk storage of data and 

instructions. Large files and databases are stored on secondary storage devices. These devices 

include hard disk, optical disks, magnetic tapes and floppy disks. Data and instructions from 

secondary storage devices are transferred to main memory and cache memory in small measures 

for the CPU to access them for processing. 

 

 

Computer Memory are three types : 

1. Primary Memory/Main Memory 

2. Secondary Memory 

3. Cache Memory 

 

 

Primary Memory or Main Memory 

The main memory is used to store data and instructions currently required for processing. 

These memories are manufactured by using integrated electronic circuits or semiconductor 

device. It has limited capacity and data is lost when power is switched off. Both RAM and ROM 

are random access memories and both can be used for reading purposes. The distinguishing 

feature is RAM's ability to alter data stored in it, which is not possible with ROM. Typically 

ROM is used to store system instructions which are relatively permanent in nature. RAM is 

volatile; that is, it loses its contents if the device is electrically disconnected. 
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Primary Memory are divided into two subcategories : 

1. Random Access Memory (RAM) 

2. Read Only Memory (ROM) 

 Random Access Memory (RAM) 

The word 'random' means that the computer can access any memory cell without accessing all 

cells sequentially. That is, a memory is said to be random access memory if any part of it can be 

accessed directly (randomly) for reading or writing data in the same time irrespective of its 

location. In other words, access to this memory is independent of physical storage location of 

information on the medium. RAM is volatile as any interruption in power supply results in loss 

of data in RAM. The contents of the memory remain there as long as electrical current is 

available to sustain the memory's pattern of positive and negative charges which represent the 

two bits 1 and O.lf power fails, all the contents in the memory will be lost. 

Types of RAM : 

• Dynamic RAM (DRAM)  

• Static RAM 

 

 Read Only Memory (ROM) 
This memory uses MetaL Oxide Semiconductor TechnoLogy. RAM is read-write memory 

whereas ROM is Read-OnLy-Memory. This memory is used to store frequently used programs 

in the system. 

Types of ROM : 

• Programmable read-only memory (PROM) 

• Erasable programmable read-only memory (EPROM) 

• Electrically erasable programmable read-only-memory (EEPROM) 

 

Secondary Memory 

This type of memory is also known as external memory or non-volatile. It is slower than main 

memory. These are used for storing data/Information permanently. CPU directly does not access 

these memories instead they are accessed via input-output routines. Contents of secondary 

memories are first transferred to main memory, and then CPU can access it. 

 

In this type of memory the cost per bit of storage is low. However, the operating speed is slower 

than that of the primary storage. Huge volume of data are stored here on permanent basis and 

transferred to the primary storage as and when required. 

 

Main secoundry memory are: 

1. Magnetic Disk 

2. Floppy Disk 

3. Hard Disk 

4. Optical Disks 

 

 

Magnetic Disk The Magnetic Disk is Flat, circular platter with metallic coating that is rotated 

beneath read/write heads. It is a Random access device; read/write head can be moved to any 

location on the platter 

 

Floppy Disk These are small removable disks that are plastic coated with magnetic recording 

http://generalnote.com/Basic-computer/Primary-Memory.php
http://generalnote.com/Basic-computer/Primary-Memory.php
http://generalnote.com/Basic-computer/what-is-computer.php
http://generalnote.com/Basic-computer/Computer-Memory.php
http://generalnote.com/Basic-computer/Secondary-Memory.php
http://generalnote.com/Basic-computer/Primary-Memory.php
http://generalnote.com/Basic-computer/Primary-Memory.php


material. Floppy disks are typically 3.5″ in size (diameter) and can hold 1.44 MB of data. This 

portable storage device is a rewritable media and can be reused a number of times. Floppy disks 

are commonly used to move files between different computers. The main disadvantage of floppy 

disks is that they can be damaged easily and, therefore, are not very reliable. The following 

figure shows an example of the floppy disk. Figure 3 shows a picture of the floppy disk. 

 

Hard Disk Another form of auxiliary storage is a hard disk. A hard disk consists of one or more 

rigid metal plates coated with a metal oxide material that allows data to be magnetically recorded 

on the surface of the platters. The hard disk platters spin at 5 a high rate of speed, typically 5400 

to 7200 revolutions per minute (RPM).Storage capacities of hard disks for personal computers 

range from 10 GB to 120 GB (one billion bytes are called a gigabyte). 

 

Optical Disks Optical Mass Storage Devices Store bit values as variations in light reflection. 

They have higher area density & longer data life than magnetic storage. They are also 

Standardized and relatively inexpensive. Their Uses: read-only storage with low performance 

requirements, applications with high capacity requirements & where portability in a standardized 

format is needed. 

Types of Optical Disk 

1. CD-ROM (read only) 

2. CD-R: (record) to a CD 

3. CD-RW: can write and erase CD to reuse it (re-writable) 

4. DVD(Digital Video Disk) 

Cache Memory 

Input- Output operations are very slow. CPU speeds are quite high compared to the access time 

of main memory. Thus the processor performance is limited by the slow speed of the main 

memory. To speed up fetching of instructions to CPU, a buffer or cache (pronounced as cash) is 

used. Normal RAM is expensive and is not fast enough to match the speed of CPU. To reduce 

the processing time, certain computers use costlier and higher speed memory devices to form a 

buffer or cache. This technique uses a small memory with extremely fast access speed close to 

the processing speed of the CPU. This memory is called cache and it stores data and instructions 

currently required for processing. Cache memory thus makes main memory appear much faster 

and larger than it really is. It improves the memory transfer rates and thus raises the effective 

processor speead. 

 

The CPU searches cache before it searches main memory for data and instructions. Cache is 

physically located close to the CPU and hence access to cache is faster than to any other 

memory. 

 

 

1.10. CONCEPT OF HARDWARE 
Hardware: The physical parts of a computer. the system is a group of various components that 

work together to achieve a specific goal or target...the computer mainly consists of hardware and 

software 
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The term hardware is used to refer to all the components inside or outside the computer. The 

hardware that are used to supply input to computer are called as input devices. The hardware that 

are used to process the data are called as processing devices and the devices that are used to 

present output of computer are called as output devices  

 

 The System Unit- the system unit is also known as case. 

o Front side 

o Back side 

 Ports 

 Expansion Slots 

o Inside 

 Motherboard ( System Board) 

 CPU (Central Processing Unit) 

 Memory, such as RAM, ROM, Cache, and Flash 

o Outside 

 Input /output  

 Communication device 

 Storage-the motherboard in the cabinet,the memory chip are installed and secondary 

storage is  connected to it.different memory drives are connected to the motherbard by a 

flat cable(ribbon cable). 

 Input / Output Devices- The input hardware devices are used to put data into computer. 

The output hardware devices are translating the processed information to the human 

 Communication Devices-peripheral device that extends a computer input, storage 

,output cababilities. 

 



 

Components Of System Unit 
the system unit is also known as case.it is the house the all the computer components and their 

connections switches in front back and inside. 

 

Backside 

 

 Ports are sockets that are on the outside othe system unit, meaning you can easily plug a 

cable into a port without opening the system unit. 

o Serial ports transmit one bit of data at a time. 

o Parallel ports transmit 8 bits of data at a time. 

o Universal Serial Bus (USB) ports are much faster than serial or parallel ports and 

allow multiple devices to be connected to the same port. 

o Scsi ports-Small Computer System Interface (SCSI)used primarily as a 

connection interface for tape drives and hard disk drives.  

o Power sockets- for connecting power to power supplyfrom external source 
 Expansion Slots are sockets on the motherboard that you can plug expansion cards into. 

To plug a card into a slot, you must open the system unit. A card contain a socket on its 

end that sticks out from the system unit so a cable can be plugged into it. Common types 

of cards are graphics, sound, and network cards. 

Inside 



 The Motherboard is the main circuit board for the computer, containing both soldered, 

nonremovable components along with sockets or slots for components that can be 

removed. The motherboard holds the CPU, RAM and ROM chips, etc.  

 

 

 

 

 The Central Processing Unit (CPU) is the "brain" of the computer. It executes 

instructions (from software) and tells other components what to do. There are 2 parts of 

the CPU: The ALU and Control Unit. 

 

 

o The Arithmetic Logic Unit (ALU) performs arithmetic operations (such as 

addition and subtraction) and logical operations (such as comparing two values). 

o The Control Unit deciphers and carries out instructions. 

 The System Clock is an "electrical pulse generator" that sends out a pulse of electricity at 

regular intervals. The electronic components of the computer need these electric pulses in 

order to perform work.  

 Power Supply -The power supply as its name might suggest is the device that supplies 

power to all the components in the computer. Its case holds a transformer, voltage control, 

and (usually) a cooling fan. uninterruptible power source (UPS) is an electrical 



apparatus that provides emergency power to a load when the input power source or mains 

power fails 

 Bus Lines are "electrical data roadways" (i.e. wires) through which bits of information 

are transmitted between the CPU and other components. The bus size denotes how many 

bits can be transmitted at once. In general, this should be the same as the CPU word size. 

Memory Unit 

 Bit (Binary Digit): Can only have a value of either 0 or 1.Byte: 8 bits (also known as 

a Character). 

 Kilobyte: 1024 bytes (or 2^10 bytes). 

 Megabyte: 1024 * 1024 bytes (or 2^20 bytes). Roughly one million bytes. 

 Gigabyte: 1024 * 1024 * 1024 bytes (or 2^30 bytes). Roughly one billion bytes. 

 Terabyte: 1024 * 1024 * 1024 * 1024 bytes (or 2^40 bytes). Roughly one trillion bytes. 

 

o Random Access Memory (RAM), also known as Main Memory or Primary 

Storage, is used to hold instructions and data while they are being used. RAM is 

volatile, meaning its contents are lost when the power goes off.  

o Read Only Memory (ROM) chips are non-volatile memory that generally 

contains instructions for "booting" the computer (i.e. loading the operating system 

when the computer starts up). 

o CMOS chips are powered by a battery and contain so-called "flexible 

information" such as the type of hard drive your computer is using and the current 

date and time. 

o Flash chips do not require electricity or a battery yet are non-volatile.  

o Cache memory is special high-speed memory that temporarily stores instructions 

and data the CPU is likely to use frequently.  

 Secondary Storage-Devices that "permanently" hold data and information (i.e. 

programs). 

 Non-volatile memory; when the power goes off, contents are still saved (unless there is 

an error).Used to store instructions and data while they are not being used. 

 A floppy disk is a removable (i.e. portable) platter made of mylar plastic that is 

magnetized. Bits of information are stored in concentric rings called tracks on either side 

of the platter. The current floppy disk standard is a 3 1/2" platter in a hard plastic case 

that holds 1.44 Megabytes of information. A Zip disk, on the other hand, can hold up to 

250 Megabytes. 
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 A hard disk is similar to a floppy disk but uses metal platters to store information. Hard 

disks are not only much faster than floppy disks but can hold huge amounts of data 

(hundreds of gigabytes). 

 

 Both floppy and hard drives use a read/write head, which is basically a magnet, to 

read/write information from/to tracks on a platter. In a hard drive, the read/write head and 

platter(s) are enclosed together in an air-tight package, making hard drives less 

susceptible to damage. The read/write head hovers above the platter but should not touch 

it. If touched, the platter can be damaged, resulting in the loss of some or all the data on 

the platter. This is known as a head crash. 

 Magnetic tape is used mostly for backups. These are very slow because you have to fast 

forward or rewind to the right spot. However, they are very reliable. 

 



 Optical discs use optical technology (i.e. lasers) instead of magnetic technology to store 

information. 

 

o CD-ROM stands for Compact Disc - Read Only Memory. 

o CD-R stands for Compact Disc - Recordable and can be written to only once. 

(Also known as CD-WORM: Compact Disc - Write Once, Read Many.) 

o CD-RW stands for Compact Disc - Re-writeable (or Read/Write). 

o DVD-ROM stands for Digital Versatile Disc - Read Only Memory. 

o DVD-R stands for Digital Versatile Disc - Recordable and can be written to only 

once. 

(Also known as DVD-WORM: Digital Versatile Disc - Write Once, Read Many.) 

o DVD-RW stands for Digital Versatile Disc - Re-writeable (or Read/Write). 

o CD's can hold approximately 650 Megabytes of data while DVD's can hold up to 

17 Gigabytes. 

Front Side 

o  



 Power switch: The power on/off switch is used to turn on or off the power to the PC. 

 Reset button: This button helps you restart your computer without disconnecting the 

power supply. 

 Lights: The front panel of the system unit may display a variety of colored indicator 

lights. These lights are used to indicate whether the hard disk, the floppy disk or the CD-

ROM is being read or written. 

 Floppy Disk drive: The floppy disk drive is used to read the information stored in floppy 

disks (also called a diskette).  

  DVD/CD Combo Drive: A simple combo drive allows you to save data on CD and look at 

data in a DVD but not let you save any data on DVD. For saving data on DVD you need an 

enhanced version of combo drive which includes functionality to save data on DVD. 

 

Input / Output Devices 

 Input devices translate data into a form the computer can understand. 

o The keyboard is the most common input device, but this type of data entry is 

very slow and error-prone. 

o Direct input devices are much faster and less error-prone. 

 Pointing devices such as the mouse, trackball, and touchpad allow you to 

manipulate a cursor on the screen. 

 Scanning devices read data directly. For example, OMR (Optical Mark 

Recognition) devices (such as a scantron machine) can sense marks on 

paper. Even more advanced are OCR (Optical Characgter Recognition) 

devices, which attempt to read letters. Bar Code Readers are often used in 

grocery stores to scan items. 

 Output devices translate information into a form humans can understand. 

o The Monitor (or Display Screen) is the most common type of output device. It 

produces softcopy (i.e. temporary) output on a screen. 

o The Printer is the most second most common type of output device. It 

produces hardcopy (i.e. "permanent") output on paper. 

 A Laser Printer uses a photoelectric drum and powdered ink, similar to a 

copying machine, to produce output. 

 An Inkjet Printer produces output by spraying droplets of liquid ink onto 

the paper from small nozzles. It is the most common type of printer in use 

today and is generally very inexpensive. 

Communications Devices 

 These allow your computer to send/receive data to/from other computers. 

 A modem sends information over a phone line. Modems are slow and susceptible to 

problems such as phone line static. 



  
 A network card sends information over a network cable. These can be used to hook up a 

computer to a local area network (LAN) or to an Internet Service Provider via a cable 

modem or DSL (for Internet access). 

1.11 CONCEPT OF COMPUTER SOFTWARE 

 

As you know, the hardware devices need user instructions to function. A set of instructions that 

achieve a single outcome are called program or procedure. Many programs functioning together 

to do a task make a software. 

There are different categories of software − 

 System Software 

 Application Software 

 Utility Software 

. 



 

System Software 

Software required to run the hardware parts of the computer and other application software are 

called system software. System software acts as interface between hardware and user 

applications.  

Machines understand only binary language i.e. 0 (absence of electric signal) and 1 (presence of 

electric signal). Software is required to convert all human instructions into machine 

understandable instructions.  

 Operating System 

 Language Processor 

 Device Drivers 

 

 Operating System 

System software that is responsible for functioning of all hardware parts and their 

interoperability to carry out tasks successfully is called operating system (OS). OS is the first 

software to be loaded into computer memory when the computer is switched on and this is 

called booting. OS manages a computer’s basic functions like storing data in memory, 

retrieving files from storage devices, scheduling tasks based on priority, etc. 



 Language Processor 

system software is to convert all user instructions into machine understandable language.  

 Machine-level language − This language is nothing but a string of 0s and 1s that the 

machines can understand. It is completely machine dependent. 

 Assembly-level language − This language introduces a layer of abstraction by 

defining mnemonics. Mnemonics are English like words or symbols used to denote a 

long string of 0s and 1s. The complete instruction will also tell the memory address. 

Assembly level language is machine dependent. 

 High level language − This language uses English like statements and is completely 

independent of machines. Programs written using high level languages are easy to 

create, read and understand. 

Program written in high level programming languages like Java, C++, etc. is called source 

code. Set of instructions in machine readable form is called object code or machine 

code. System software that converts source code to object code is called language processor. 

There are three types of language interpreters− 

 Assembler − Converts assembly level program into machine level program. 

 Interpreter − Converts high level programs into machine level program line by line. 

 Compiler − Converts high level programs into machine level programs at one go 

rather than line by line. 

 Device Drivers 

System software that controls and monitors functioning of a specific device on computer is 

called device driver. Each device like printer, scanner, microphone, speaker, etc. that needs to 

be attached externally to the system has a specific driver associated with it. When you attach a 

new device, you need to install its driver so that the OS knows how it needs to be managed. 

Application Software 

A software that performs a single task and nothing else is called application software. 

Application software are very specialized in their function and approach to solving a problem.  

 

 Commercial software -commercial software: these programs available as an online 

download. Once the trial period is over, the user can pay for the program directly on the 

Web site and download an official copy 

 Public domain software -Public domain software is not copyrighted. It is released without 

any conditions upon its use, and may be used without restriction. This type of software 

generally has the lowest level of support available. 

 Freeware -Freeware has no cost and can be downloaded from the Internet without any 

charges.  

 Shareware -This is a software that can be used on a trial basis. Once the time limit of 

shareware expires, the user is asked to pay for continuation of the services. 



 

 

 

Application software tools 

1) Word Processing Software: Word Processing software is used to manipulate, format the text, 

to create memos, letters, faxes and documents. For example Microsoft Word, Lotus Word 

Pro, Word pad and Corel WordPerfect. 

2) Spreadsheet Software: Spreadsheet software is used to perform manipulate and 

calculations. In spreadsheet software data is stored in intersection row and column. The 

intersection of row and column is known as a cell. For example Microsoft Excel, lotus 1-2-3 for 

windows and number for MAC OS. 

3) Database Software: Database is a collection of data related to any applications. When we 

operate the application data is accessed from the database, and after manipulation, it gets back 

stored in the database.For example Database Management System (DBMS) software tool used 

for storing, modifying extracting and searching for information within a database. MySQL, MS 

Access, Microsoft SQL Server and Oracle is the example of database application Software. 

4)Business  software  These programs are built to facilitate certain business functions, 

improving the accuracy, efficiency, and effectiveness of operations. Business application 

software programs achieve measurable objectives such as saving work time and enhancing 

productivity. Below are some popular examples of business applications that are commonly 

used by organization 

5)Presentation Software: Presentation program is a program to show the information in the 

form of slides. The software has three components:1) Text editor for inputting and formatting 

text.2) Inserting graphics, text, video and other multimedia files.3) Slideshow to display 

the information.We can add text, graphics video and images to slides to make them more 

informative. Presentation software helps the presenter to present their ideas with ease and visual 

information easy to understand. Example of presentation software: Microsoft’s PowerPoint 

and Apple’s Keynote. 

6)Education and Reference Software: These types of software are specifically designed 

to facilitate learning on a particular subject. There are various kinds of tutorial software 

that fall under this category. They are also termed as academic software. Some examples 

are:DeltaDrawing,GCompris, Jumpstart titles,KidPix, MindPlay,Tux Paint 
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7)Games/Entertainment: This area deal with the general public, media and 

telecommunication. With the growth entertainment mode, many application is available 

for mobile phone as well as the system. Like Music and video entertainment app, 

navigation app, social networking application, news and weather application, educational 

apps and e-book reader’s app for preparation of any type of exams.  

8)Web Browsers: These applications are used to browse the internet. They help the user 

in locating and retrieving data across the web. Some examples of web browsers 

are:GoogleChrome,InternetExplorer,MicrosoftEdge,MozillaFirefox,Opera,Safari,UC 

Browser 

9) Authoring/Multimedia Software: Multimedia is a combination of text, graphics, audio and 

Multimedia software used in the editing of video, audio and text. Multimedia software used in 

the growth of business, educations, information, remote system and entertainment. 

10.Graphics Software: As the name suggests, Graphics Software has been devised to work 

with graphics as it helps the user to edit or make changes in visual data or images. It 

comprises of picture editors and illustration software. Some examples are:Adobe 

Photoshop, Autodesk Maya, Blender ,Carrara,CorelDRAW,GIMP,Modo,PaintShop Pro 

11.Web-based applications:While most application software can be installed directly to a 

machine, many allow users to access tools through web browsers and some only exist in web 

format. Not only do these services free up space on a user's hard drive or network, being web-

based means they can be accessed from anywhere in the world at any time, with data being 

stored in the cloud. This also means the application is kept up-to-date automatically, without the 

risk of a user running an insecure version. 

Utility Software 

Application software that assist system software in doing their work is called utility software. 

Thus, utility software is actually a cross between system software and application software. 

Examples of utility software include − 

 Antivirus software 

 File management tools 

 Compression tools 

 Disk management tools 

 Backup tools 

 

 Antivirus:It is used to protect a computer from the virus. It detects a virus and notify the 

user and take action to secure the computer. The virus are kept in different location called 

vault where it has different file system due to which virus effect it. User can itself instruct 

antivirus to delete malicious program, put it in vault or even ignore it. These days most 

come in GUI form. 

 



 File Management Tool:The software is used to manage files stored in a file system. It 

can be used to create, group file. File management tool is a data structure used to store 

file in a OS while later is used to perform task on file stored in the file System.Like 

Windows File Explorer is a file management tool. 

 

 Compression Tool:These tool are used to reduce the size of a file based on the selected 

algorithm.Most operating systems include tools for compressing and uncompressing 

files.Linux has tools for both .tar.gz and .zip. Other compressed files, like .7z and .rar, 

require a third-party compression utility to be installed. 

 

 Disk Management Tool: It enables us to view or managed the disk drives installed in 

their computer and the partition associated with those drives. Disk Management is used to 

managed the drives installed in a computer- like hard disk drives, and flash drives. It can 

be used to partition drives, assign drive letters and much more. 

 

1.Disk Cleanup Tool : It allows user to remove files that are no longer needed or 

that can be safely deleted. Removing unnecessary files, including temporary files, 

can help to improve the functioning and increase the free space of the computer. 

 Running Disk Cleanup at least once a month is an excellent maintenance task. 

Disk Cleanup tool can delete temporary internet files, old check disk files, 

compress old filesand offline webpages. Disk cleanup also allows you to empty 

the Recycle Bin, delete temporary files, and delete Thumbnails. 

 

2.Disk Defragmenter:It is a utility in Microsoft Windows designed to increase 

access speed by rearranging file stored on a disk to occupy contiguous storage 

locations, a technique is calledDefragmentation.Defragmenting a disk minimizes 

head travel, which reduces the time it takes to read files from and write files to the 

disk.The defragmenter will search your hard drive partition and move data from 

one location to other location, so that the files stored there are one contiguous 

piece, instead of being throughout multiple locations on the harddrives partition. 

 Backup :Backup utility enables backing up of files, folders, databases or complete disks. 

Backups are taken so that data may be restored in case of data loss. Backup is a service 

provided by all operating systems. In stand-alone systems backup may be taken in the same or 

different drive. In case of networked systems backup may be done on backup servers. 

QUESTIONS 

1. Define: computer. 

2. List out some applications of computer. 

3. Discuss about volatile and nonvolatile memory. 

4. What is hardware and software 

5. Write a short note on CPU. 

6. Briefly explain the input devices. 

7. Briefly explain the output devices  

8. Discuss about the concept of hardware. 

9. Discuss about the concept of software 

10. Discuss about computer memory devices in brief. 

11. Explain computer components in detail. 



FUNDAMENTALS OF COMPUTER-7BSOA1 

UNIT-II 

 DATA PROCESSING:  

 CONCEPTS OF DATA PROCESSING,  

 DEFININTION OF INFORMATION AND DATA,  

 BASIC DATA TYPES,  

 STORAGE OF DATA/INFORMATION AS FILES, 

 (NUMBER SYSTEM- REPRESENTATION OF DATA/INFORMATION. 

2.1. DATA PROCESSING: INTRODUCTION 

Data are raw facts. Tuning data into information. Data processing occurs when data is collected 

and translated into usable information. Data processing starts with data in its raw form and 

converts it into a more readable format (graphs, documents, etc.), 

2.2. CONCEPT OF DATA PROCESSING 

DATA 

Data are raw facts that are processed into information. Data refers to the raw facts that do not 

have much meaning to the user and may include numbers, letters, symbols, sound or images. 

INFORMATION 

Information is data that has been summarized or manipulated for use in decision making. 

Information refers to the meaningful output obtained after processing the data. 

DATA PROCESSING 

Data in range of forms from various sources entered into the computer and manipulated to 

produce useful information. Data processing therefore refers to the process of transforming raw 

data into meaningful output i.e. information. 

Data processing can be done manually using pen and paper. Mechanically using simple devices 

like typewriters or electronically using modern data processing tools such as computers. 

 

 



 

2.3. DATA PROCESSING STEPS. 

1. Data coding 

2. Data input 

3. Data editing 

4. Data manipulation 

 

DATACODING 

Data coding involves labeling the responses in unique and abbreviated way(simple numeric 

codes).ex: coding done by interviewers 

Closed questions – fixed number of predetermined responses allowed 

Open questions -any response coding is difficult. 

DATA INPUT 

The keyboard of computer is the data entry devices. Punched Cards, scanners, barcode reader 

etc. 

DATA EDITING 

Check the accuracy to eliminating the problems are disorganized incorrect information 

Validity check-it ensure that data fall within set limit 

Verification check – it checks the accuracy of entered data by entering it again and comparing 

the two results. 

Consistency check – it checks the logical consistency of answers. 

DATA MANIPULATION 

The data manipulation stage data may be manipulated by computer to produce the desired 

output. The software used to manipulate data will depend on the form of output required. 

Spread sheet – are used to create formulas that automatically add columns or rows 

Database-systematically stored data for easy access to produce summaries stock reports. 

Charts-can be created from a table of numbers and displayed in a number of ways. (bar chart, 

linecharts, pie chats ect). 

 



 

2.4 BASIC DATA TYPES 

Computer systems work with different types of digital data. In the early days of computing, data consisted 

primarily of text and numbers, but in modern-day computing, there are lots of different multimedia data types, 

such as audio, images, graphics and video. Ultimately, however, all data types are stored as binary digits. For 

each data type, there are very specific techniques to convert between the binary language of computers and 

how we interpret data using our senses, such as sight and sound. 

Character Strings 

One of the most basic data types is plain text. In database terminology, this is referred to as a character string, 

or simply a string. A string represents alphanumeric data. This means that a string can contain many different 

characters, but that they are all considered as if they were text and not put into calculations, even if the 

characters are numbers. 

Numeric Data Types 

The second most important data type is numeric data. As a general rule, you store numbers only as a numeric 

data type  

Integer 

There are several different types of numeric data. An integer is a numeric value without a decimal. Integers are 

whole numbers and can be positive or negative.  

Float 

A number with a decimal is referred to as a decimal, a float or a double. The terminology varies somewhat 

with the software being used. The term float comes from 'floating point,' which means you can control where 

the decimal point is located. The term double refers to using double the amount of storage relative to a float. 

2.5. STORAGE OF DATA / INFORMATION AS FILES 

Types of computer files 

i) Report file- It contains a set of relatively permanent records extracted from the data in a master file. 

They are used to prepare reports, which can ve printed at a later date, e.g. report on student’s class 

performance in the term, extract of students who have not cleared their school fees, report on 



absentees 

ii) Backup file- Used to backup data or to hold duplicate copies of data/information from the computer’s 

fixed storage or main file for security purposes e.g. a copy of all the students admitted in a school fees, 

report on absentees 

iii) Reference file - Used for reference purposes. It contains records that are fairly permanent or semi-

permanent, e.g. Deductions in caution money, wage rates, tax deductions, employees address, price lists 

etc. 

iv) Sort file – used to sort/rank data according to a given order, e.g. ranking position in a class of 

students. 

v) Transaction file - Is used to hold input data during transaction processing. It is later used to update 

master files and audits daily, weekly or monthly transaction. 

 

File organization methods 

File organization refers to the way data is stored in a file. File organization is very important 

because it determines the methods of access, efficiency, flexibility and storage devices to use. 

There are four methods of organizing files on a storage media. This include: 

 Sequential, 

 Random, 

 Serial  

 Indexed-sequential 

Sequential file organization- 

records are stored in a sorted order using a key field, Records are stored and accessed in a 

particular order sorted using a key field. Retrieval requires searching sequentially through the 

entire file record by record to the end. 

Random or direct file organization 

Records are stored randomly but accessed directly.To access a file stored randomly, a record 

key is used to determine where a record is stored on the storage 

media.Magnetic and optical disks allow data to be stored and accessed randomly. 

Serial file organization 

Records in a file are stored and accessed one after another.The records are not stored in any 

way on the storage medium this type of organization is mainly used on magnetic tapes. 

Indexed-sequential file organization method 

Almost similar to sequential method only that, an index is used to enable the computer to 

locate individual records on the storage media. For example, on a magnetic drum, records are 

stored sequential on the tracks. However, each record is assigned an index that can be used to 

access it directly. 

2.6.NUMBER SYSTEM 



 

 

 

 



 

 

 

 

 

 

 



 



 

 

 

 



 

 

 



 



 

 



 

 

 

 

 



 

 

 



 

 

 

 



 

 

 

 



 

 

 

 

QUESTIONS  

1. Define: Data and Information. 

2. Write a short note on CPU. 

3. How to store data and information as files. 



4. Explain the concept of data processing. 

5. Briefly explain the binary representation of integers. 

6. Convert the following 

i. (22.21875)10=(?)8 

ii. (F3A.CB)16=(?)2 

iii. (1795)10=(?)16 

  

 

 



UNIT-III 

OPERATING SYSTEM – MS-WINDOWS:  

 OPERATING SYSTEM: DEFINITION & FUNCTIONS 

 BASICS OF WINDOWS 

 BASIC COMPONENTS OF WINDOWS 

 TASKBAR, ACTIVATING WINDOWS,USING DESKTOP,TITLE BAR, RUNNING APPLICATIONS, 

 ICON-TYPES OF ICONS, 

 EXPLORING COMPUTER,  

 MANAGING FILES AND FOLDERS,  

 COPYING AND MOVING FILES AND FOLDERS. 

 CONTROL PANEL  

 DISPLAY PROPETIES,  

 ADDING AND REMOVING SOFTWARE AND HARDWARE, 

 SETTING DATE AND TIME. 

 SCREN SAVER AND APPEARANCE. 

3.1. OPERATING SYSTEM 

An Operating System (OS) is an interface between computer user and computer hardware. An 

operating system is software which performs all the basic tasks like file management, memory 

management, process management, handling input and output, and controlling peripheral 

devices such as disk drives and printers. 

Some popular Operating Systems include Linux Operating System, Windows Operating 

System, VMS, OS/400, AIX, z/OS, etc. 

3.1.1. DEFINITION 

An operating system is a program that acts as an interface between the user and the computer 

hardware and controls the execution of all kinds of programs. 

 



 

3.2. FUNCTIONS OF AN OPERATING SYSTEM 

Following are some of important functions of an operating System. 

 Memory Management 

 Processor Management 

 Device Management 

 File Management 

 Security 

 Control over system performance 

 Job accounting 

 Error detecting aids 

 Coordination between other software and users 

 Memory Management 

Memory management refers to management of Primary Memory or Main Memory. Main 

memory is a large array of words or bytes where each word or byte has its own address. 

Main memory provides a fast storage that can be accessed directly by the CPU. For a program 

to be executed, it must in the main memory. An Operating System does the following activities 

for memory management − 

 Keeps tracks of primary memory, i.e., what part of it are in use by whom, what part are 

not in use. 

 In multiprogramming, the OS decides which process will get memory when and how 

much. 

 Allocates the memory when a process requests it to do so. 

 De-allocates the memory when a process no longer needs it or has been terminated. 

 Processor Management 

In multiprogramming environment, the OS decides which process gets the processor when and 

for how much time. This function is called process scheduling. An Operating System does the 

following activities for processor management − 

 Keeps tracks of processor and status of process. The program responsible for this task is 

known as traffic controller. 

 Allocates the processor (CPU) to a process. 

 De-allocates processor when a process is no longer required. 

 Device Management 

An Operating System manages device communication via their respective drivers. It does the 

following activities for device management − 



 Keeps tracks of all devices. Program responsible for this task is known as the I/O 

controller. 

 Decides which process gets the device when and for how much time. 

 Allocates the device in the efficient way. 

 De-allocates devices. 

 File Management 

A file system is normally organized into directories for easy navigation and usage. These 

directories may contain files and other directions. 

An Operating System does the following activities for file management − 

 Keeps track of information, location, uses, status etc. The collective facilities are often 

known as file system. 

 Decides who gets the resources. 

 Allocates the resources. 

 De-allocates the resources. 

 Other Important Activities 

Following are some of the important activities that an Operating System performs − 

 Security − By means of password and similar other techniques, it prevents unauthorized 

access to programs and data. 

 Control over system performance − Recording delays between request for a service 

and response from the system. 

 Job accounting − Keeping track of time and resources used by various jobs and users. 

 Error detecting aids − Production of dumps, traces, error messages, and other 

debugging and error detecting aids. 

 Coordination between other softwares and users − Coordination and assignment of 

compilers, interpreters, assemblers and other software to the various users of the 

computer systems. 

3.3. BASICS OF WINDOWS 

Windows is an operating system that manages a personal computer known as a series of 

programs. It is a Microsoft-developed graphical operating system. This offers a way of data, 

apps running, playing video games, streaming videos and internet access. Microsoft was first 

created in November 1985 and has frequently been modified as computer memory expanded, as 

chips got faster processing and, of course, when the internet was invented. PCs used a set of text 

commands before Windows. After that, more than a dozen versions, including the latest 

Windows 10 edition, were released. 

 Web Browsers 



Internet Explorer is one of the best-known Internet applications, mostly because many Windows 

models have bundled it in the last 20 years. The GUI and most common web browser features 

include your favorite bookmarking pages. Microsoft Edge substitutes for Windows 10 for 

Internet Explorer but is serving the same function. It has some additional features via Internet 

Explorer, including the option of easy to read and integrate Web pages with other Windows 10 

components. 

  Productivity 

Multiple productivity features, such as handling e-mails and schedules, following directions and 

organizing notes, are included in Windows 8 and 10. Mail and Calendar are software that links 

your accounts, for example, to Microsoft, Google and Apple. Within these services, you 

synchronize your mailboxes and calendars and display them on your computer in a single 

window. 

Maps, a Bing Maps app that allows you to use all the same navigation and search apps. It also 

introduces a few additional functionalities, such as pinning and saving instructions on all 

Windows tools. 

One Note, which originally came with Microsoft Office, is the advanced notice management 

program, but now it’s a default Windows 10 feature. OneNote helps you to create a notes list, 

which you can search and share. 

  Settings 

You can change the settings and configurations of your computer in the Control Panel. The 

Windows 8 Settings app provides you with access for the most part to your device settings, but 

instead of the traditional Windows, the modern tablet model. 

  Advantages 

Now we will first be going to see the advantages: 

Ease to Use: The more modern ones are possibly simple for users familiar with previous 

versions as well. Perhaps that is due to the uniform look and feel of virtually perhaps the 

systems and the way the file system has been implemented since the days of MS 

Windows. 

Available Software: It is equipped with a large range of applications. This is both 

because of and why Microsoft is a world leader in Desktop operating systems and bureau 

applications. When you are searching for your business program, a Windows version is 

likely to be available somewhere if the product exists. 

Backward Compatibility: If you are currently using the older edition and need more 

up-to-date details but don’t want to compromise the use of any older Window only 

programs that are important to your business needs, it’s possible that such programs will 

operate with a newer version. 

Plug & Play: Windows is also a specialist in plug & play support for PC hardware, as an 

operating system for the average home user. As long as you install the right drivers, 

Windows typically does an outstanding job of recognizing new hardware. Many 

operating systems do have Plug & Play features, but require manual control to a lesser 

degree and more frequently. 



Games: You need Windows if you want the latest innovations in PC Gaming. It 

provides plenty of gaming games as well as other different supporting gaming hardware. 

There are also some of the most common games for Linux and some for the Mac, but no 

comparison really. Nevertheless, all the outdated games written for Windows 95 and 98 

aren’t going to work with XP, as well. 

  Benefits and Features 

Allows the user to interact with the computer (through the keyboard, mouse, microphone, etc.). 

Controls the storage of data (images, files, music). 

Controls hardware attached to the computer such as webcams, scanners and printers. 

Helps to open and close programs (word processors, games, photo editors, etc.), and gives them 

part of the computer’s memory to allow them to work. 

Controls what access to a computer different users have and the computer's security. 

Deals with errors and user instructions, and issues simple error messages. 

Promotes multitasking by allowing the user to do several things on the computer at once – for 

example, watch a video while writing a letter. 

   

 1. Windows 1.0 

 

It was released on November 20, 1985  

Used Graphical User Interface 

 2. Windows 2.0 

 

It was released on December 9, 1987 

16 bit Graphic User Interface (GUI) based operating 

environment 

Introduced Control Panel, and the first version of MS Word and 

Excel 

 3. Windows 3.0 

 

It was released in 1990 ,It was better at multitasking 

Used 8086 microprocessors 

  

4. Window 95 

 

It was the first complete Operating System  

It was released on August 15, 1995 

It merged MS-DOS and Windows products 

Advanced from 16 bit GUI to 32 bit GUI 

 5. Windows 98 

 

It was released to manufacturing on May 15, 1998 

It was a 16 bit and 32 bit product based on MS DOS 



 6. Windows 2000 

 

It was officially released on February 17, 2000. However, its 

manufacturing had begun in late 1999 

It was considered as one of the most secure OS ever 

A local disk manager was introduced with these Windows 

 7. Windows XP 

 

While the manufacturing started on August 24, 2001, the 

official product was released on October 25, 2001 

Automatic wireless connection support 

 8. Windows Vista 

 

It was released on January 30, 2007 

It was the first operating system to use DVD-ROM for 

installation 

 9. Windows 7 

 

It was released on October 22, 2009 

Libraries were added in the file management system 

 10. Windows 8 

 

It was released for retail on October 26, 2012,touch-based 

Installed in new devices like Laptops, Mobile phones, tablets  

Online Applications could be directly downloaded 

 11. Windows 10 

 

It was released on July 29, 2015 

Addresses shortcomings in the user interface first introduced 

with Windows 8 

A virtual desktop system 

 

3.4. BASIC COMPONENTS OF WINDOWS 

Windows is an essential part of a Computer. It’s the most commonly used 

Operating System all around the world both individually and commercially. 

Since the beginning of the creation of Windows, there are many versions of 

Windows like Windows XP, Vista, 8, 10, etc. 



 

Windows consists of the following components: 

 Icons : Icon is a small graphical representation of a program or file. When 

we double-click an icon, the associated file or program will be opened. 

For example, if we were to double-click on the My Computer icon, it 

would open Windows Explorer. 

 

 

http://www.whenparentstext.com/wp-content/uploads/2019/11/MicrosoftVista-4x3.jpg


TYPES OF ICONS 

a.  Disk Drive/ Document Icons 

b.  Application Icons 

c.  Toolbar Icons 

d.  Menu Icons 

 Taskbar:The taskbar is a simple row at the very bottom of the screen 

where all currently opened files or applications are listed. It helps you 

select what you want to keep opened and what you want to close.  

 Desktop: The desktop is the very first screen we see after windows start. 

Here, we can see folders like My Computer, Documents, etc. It is the 

main working area of many of your computer operations. You keep your 

special files on the desktop so you can access them easily and it gives 

access to other important functionalities as well such as search bar, 

taskbar, and file explorer. 

 Title Bar :The title bar is a horizontal bar located at the top of 

a window in a GUI. It displays the title of the software, name of the 

current document, or other text identifying the contents of that window. 

For example, in the picture below, the title bar displays the program name 

"TextPad" and the document name "Document1" that is currently being 

edited. Besides giving a description of the open program or window, the 

title bar may also contain other useful features that depend on the 

operating system and program showing the title bar.  

  

https://developer.gnome.org/hig-book/unstable/icons-types.html.en#document_icons
https://developer.gnome.org/hig-book/unstable/icons-types.html.en#application_icons
https://developer.gnome.org/hig-book/unstable/icons-types.html.en#toolbar_icons
https://developer.gnome.org/hig-book/unstable/icons-types.html.en#menu_icons
https://www.computerhope.com/jargon/w/window.htm
https://www.computerhope.com/jargon/g/gui.htm
https://www.computerhope.com/jargon/s/software.htm
https://www.computerhope.com/jargon/d/document.htm


• Start Menu:By clicking the start menu, in the bottom left corner of the screen, 

a vertical window consisting of the recently opened applications and saved 

locations will pop-up. Although the Start Menu was a major component of 

Windows before Windows 8, It was removed from Windows 8 and then brought 

back in Windows 10. 

• Maximize/Minimize/Close Buttons:These buttons are located at the top right 

corner of our opened documents, and the area used to close, minimize or 

maximize the document window. They help us jump from one task to another 

fast and let us decide either we want to close an application or resize it’s area on 

the screen or just hide it for a few moments. 

• My Computer:When we double click on My Computer, We find ourselves 

looking at a window where we can navigate between Computer Drives and 

Control Panel tools. It also gives us access to different drives on our computer 

and the data which lies in those drives. 

• My Computer Right Click Menu:When we right-click on My Computer or 

any other file or folder, We get a menu where we can look into different options 

related to that specific file, for example, Properties, etc. 

• Recycle Bin:When we delete a file or folder, It goes into the Recycle Bin from 

where It can either be restored or permanently deleted from the Computer. 

Once, a file or folder is deleted from the Recycle Bin, It is very difficult to 

recover it again. Therefore, the utility of the recycle bin is very essential t o use 

properly if you deal with important documents and files on a day to day basis.  

• Shortcut:A shortcut creates a button or icon which typically is located on the 

Desktop. By clicking on this Shortcut, We can quickly open the document or 

application of which it is a shortcut. It helps us save the tedious task of going to 

the main directory again and again and saves our time. 

• Mouse Functions:The mouse is an input device which is essential in the 

working of a computer. It performs several important funct ions on Windows 

like Scrolling, Right and Left Clicks, etc. It performs another very important 

function of modern windows which is pointing towards different things and 

giving special instructions whenever needed. 

http://www.wiki-security.com/wiki/Parasite/WindowsProWebHelper/


• Highlight:When we have opened a document, we can easily highlight the 

required portion of our document by using Mouse. It is essential for documents 

and helps keep track of useful information. 

• Copy/Cut/Paste:These options are one of the most essential components of 

Windows. The copy is used to copy a portion of a document from one document 

to another or a file or folder from one location to another. The paste is used to 

paste the copied item on the desired location. While Cut is used to move an item 

to our desired location in the Computer. 

• Toolbar:The toolbar is a simple row where we can see different options to 

customize the look of our opened window. It has two types, Formatting Toolbar, 

and Standard Toolbar. The standard toolbar consists of options like new 

documents, save a document, etc. While Formatting Toolbar consists of options 

like font size, font type, etc. 

• Drag/Drop:Dragging an object means to move an object (file or folder) from 

one location to another and when we reach our desired location, then we can 

drop the object to that location. It is one of the most used features of windows 

as you have to move files from one location to another. 

• File Extensions:File extensions are used to define the type of the file. For 

example an image file will have an extension of .jpg, .jpeg and a Word 

document will have an extension .docx, .xls, .txt etc. You could have different 

types of extensions and these extensions help you decide the type of software 

that will be used to access these files. 

• Multitasking:The term Multitasking means to run more than one file or 

application on Windows at the same time. It is a very important component of 

Windows which saves our time as well as allow us to perform more tasks at the 

same time. 

• Virtual Keyboard:A virtual keyboard is a software through which we can see 

a keyboard on our screen and use it by our Mouse. It is mostly used in the cases 

when your keyboard is not working properly or you use windows on a touch 

device. 



• Disk Drives:Disk Drives are drives used to store applications and files. Hard 

Drives and Floppy Drives are used for this purpose. They are very important for 

your instructions as well as your hardware to work properly. 

• Defragmenting Hard Drives:Defragmenting a Drive means to erase all the 

data from that drive. It is also another important component of windows as users 

need to clean up their hard drives from time to time and it also comes as a built -

in utility. 

 Windows Explorer :Windows Explorer is a file manager program that 

allows you to browse the contents of your hard drive. With Windows 

Explorer, you can browse your pictures, music, documents and videos 

from one location. You have three ways you can open Windows Explorer 

in Windows 7. 

Step 1 - Right-click the "Start" menu and click "Open Windows Explorer." 

Windows Explorer opens for you to browse your hard drive's contents.  

Step 2 - Press the "Windows" and "E" keys on the keyboard and Windows 

Explorer opens for you to browse your hard drive's contents 

step 3 - Click the "Start" menu and type "explorer" in the instant search box. 

Windows Explorer appears in the list for you to click. 

3.5  MANAGING FILES AND FOLDERS: 

  

 Each of these is a folder. They may contain files or other folders (called subfolders) or 

both. There may be many “nestlings” of folders within folders. 

https://www.whenparentstext.com/category/tips/


 

 Files and folders are located on the computer by using a file path. 

  The “James” folder is located inside a folder called “Home”, which is located inside a 

folder called “as-net”, which is located on the “C:” drive. The file path will be “C:\es-

net\Home\James”. 

3.6 CREATING FILES AND FOLDERS 

 

 This is mercifully easy. Simply right-click on some empty space in any suitable folder or 

the desktop and choose to create a new object from the choices offered. 

 Be careful not to alter the file extension, as this can render the file unreadable. File 

extensions are usually hidden for this reason. 

3.6.1 COPY FILES AND FOLDER 

To copy files and folders, select the Copy tab and specify the following values: 

 

Parameter Description 

Select Action Type 

Select the Action from any of the following for HTTP : 

 Files 

 Files as archive 

Select the Action from any of the following for network 

share: 

o Copy a File - To copy a file from one location to another 

o Copy a File to a Folder - To copy a file from one location 

to a specified folder 



o Copy Multiple Files - To copy multiple files to a specified 

folder 

o Copy a Folder - To copy a folder from one location to 

another 

Source File 

Specify the file that has to be copied. The file can either be 

in a shared location or in the specified location in the client 

machines. 

Destination Folder Specify the destination location to copy the files/folders. 

Overwrite Existing Files Select this option to overwrite the existing files. 

Create Destination Directory if 

doesn't Exist 

Select this option to create the destination directory, if it 

does not exist. 

Modified, Created, Accessed 
Select this option to specify the modified, created or 

accessed details of the file/folder. 

  

If you wish to copy more files/folders, click Add More Action button and repeat step 2. The values gets added 

to the List of File Actions table. 

3.6.2 RENAME/MOVE FILES AND FOLDERS 

 

To rename or move the files and folders, select the Rename/Move tab and specify the following values: 

Parameter Description 

Select Action Type 

Select the Action from any of the following: 

 Rename/Move a file 

 Rename/Move a folder 

Source File/Folder Specify the file or the folder that has to be copied 

Destination File/Folder Specify the destination file or the folder. 

  

If you wish to copy more files/folders, click Add More Action button and repeat step 2. The values gets added 

to the List of File Actions table. 



3.6.3. DELETE FILES AND FOLDERS 

To delete the files and folders, select the Delete tab and specify the following values: 

 

Parameter Description 

Select Action Type 

Select the Action from any of the following: 

 Delete a File 

 Delete Multiple Files 

 Delete a Folder 

Source File Specify the files/folders that has to be deleted 

Include Read Only Files 
Select this option, if you wish to copy the files even if it has 

only read-only permissions 

Include System Files Select this option if you wish to copy the system files. 

Include Hidden Files Select this option if you wish to copy the hidden files. 

Modified, Created, Accessed 
Select this option to specify the modified, created or 

accessed details of the file/folder. 

To modify a file action from the List of File Actions table, select the appropriate row and click  icon and 

change the required values. 

To delete a file action from the List of File Actions table, select the appropriate row and click  icon.  

3.7 CONTROL PANEL 

Control Panel is the centralized configuration area in Windows. It changes nearly 

every aspect of the operating system, including keyboard and mouse function, 

passwords and users, network settings, power management, desktop backgrounds, 

sounds, hardware, program installation and removal, speech recognition, and parental 

control. 

Think of Control Panel as the place to go in Windows if you want to change something about 

how it looks or works. 

 

 



3.7.1 HOW TO ACCESS THE CONTROL PANEL 

 In recent versions of Windows, Control Panel resides in the Windows System folder or 

category in the Apps listing. 

 In other versions of Windows, click Start and then Control Panel or Start, 

then Settings, then Control Panel. 

 See How to Open Control Panel for detailed, operating system specific directions. 

 Although it's not an "official" way to open and use the options in Control Panel, 

there's also a special folder you can make in Windows called God Mode that 

gives you all the same Control Panel features but in a simple one-page folder. 

3.7.2 HOW TO USE THE CONTROL PANEL 

The Control Panel itself is really just a collection of shortcuts to individual components called 

control panel. Therefore, to use Control Panel really means to use an individual applet to change 

some part of how Windows works. 

If you're looking for a way to access the areas of Control Panel directly, without first going 

through Control Panel, see our List of Control Panel Commands in Windows for 

the commands that start each applet. Since some applets are shortcuts to files with the .CPL file 

extension, you can point directly to the CPL file to open that component. 

For example, control timedate.cpl works in some versions of Windows to open the Date and 

Time settings, and control hdwwiz.cpl is a shortcut to Device Manager. 

The physical location of these CPL files, as well as folders and DLLsthat point to 

other Control Panel components, are stored in the Windows Registry HKLM hive, 

under \SOFTWARE\Microsoft\Windows\Current Version\; the CPL files are found 

in \Control Panel\Cpls and all the rest are in \Explorer\Control Panel\Namespace. 

3.7.3 CONTROL PANEL VIEWS 

The applets in Control Panel display in two major ways: by category or individually. All Control 

Panel applets are available either way but you may prefer one method of finding an applet over 

the other: 

3.7.4 CONTROL PANEL AVAILABILITY 

Control Panel is available in nearly every Microsoft Windows version including Windows 

10, Windows 8, Windows 7, Windows Vista, Windows XP, Windows 2000, Windows ME, 

Windows 98, Windows 95, and more. 

Throughout the history of Control Panel, components were added and removed in every newer 

version of Windows. Some Control Panel components were even moved to the Settings app and 

PC Settings in Windows 10 and Windows 8, respectively. 

https://www.lifewire.com/god-mode-windows-4154662


Even though Control Panel is available in almost every Windows operating system, 

significant differences in the number and scope of applets occur from one Windows 

version to the next. 

3.8 DISPLAY PROPERTIES 

Properties are settings that give information, status, and options for almost every element of the 

Windows system. Properties are available via the shortcut menu key on the keyboard, or a click 

of the right mouse button. Properties are different from object to object. For instance, the list of 

property options for the Windows desktop will be very different than the list of property options 

for a file. 

You can access this area in two different ways: 

 Click the Start Control Panel Display, or 

 Right-click on the desktop background and click Properties. 

When the Display Properties dialog appears there are several tabbed options available. Clicking 

the Apply button after making a change to the desktop allows you to preview the settings you've 

selected before making them final. You can always click the Cancel button to restore your 

original settings. Below is a description of the options available for each of the tab items: 

 

3.9 THEMES 

 

 

 

The options on the Themes tab allow you to set the overall desktop theme for the workstation. 

You can choose from Windows XP, Windows Classic, and more. There are also more themes 

available online, but for a fee. 

The Windows XP theme has the metallic looking start button, and a more modern looking start 

menu with the option of "pinning" your most frequently used applications to a quick access area. 



The Windows Classic look is the traditional style window and start menu we've been used to 

viewing since the Windows 95/98/NT/2000 operating systems. 

 

3.10  DESKTOP 

 

 

 

The Desktop tab enables you to select a photo, pattern or clipart to cover the background 

of the desktop. Windows comes with many preset pictures and patterns to choose from. 

1. Select the picture or pattern of your choice from the Background list box. (You also have the 

option to Browse... and select a picture stored anywhere on your computer. It will then be added 

to the scrolling background list.) 

2. Decide how to Position the image or pattern on the desktop: Stretch, Tile, or Canter. 

Then set a complimentary background Colour. (This colour would only display on the 
background if you selected a Canter option for a picture that is smaller than the window size.) 

3. If you click the Customize Desktop... button, the Desktop Items dialog appears... 

 

3.10.1  ADD OR REMOVE PROGRAMS 

How to open Add or Remove Programs in Windows XP 

 

Open the Control Panel 
1. Double-click Add or Remove Programs. 

2. A window similar to the one below should appear with a list of all the programs on your 

computer. 

4. To remove a program, select it on the list, and then click the Change/Remove button. 



See the link below for additional help with uninstalling software in Windows. 

How to open Add/Remove Programs in Windows ME and 98 

 

1. Open the Control Panel 

2. Double-click Add/Remove Programs. 

3. A window should open that allows you to uninstall software in Windows. 

  
"Add/Remove Programs" or "Add or Remove Programs?" 

Unless you're talking about very early versions of Microsoft Windows (Windows 98 or 

Windows ME), this section is called "Add or Remove Programs." 

With Windows Vista and Windows 7, if you're writing about uninstalling and managing 

software in Windows, refer to this section as "Programs and Features." With Windows 8 

and Windows 10, it should be referred to as "Apps & features." 

3.11. HOW TO SET OR CHANGE A COMPUTER'S DATE AND TIME 

Windows XP, 2000, 98, 95, NE, and NT 4 

In Windows XP and earlier versions, follow these steps to set the date and time. 

1. Navigate to the Windows desktop. 

2. Right-click the time in your Systray, usually located at the bottom-right of your screen. 

3. Click the Adjust Date/Time menu item. 

4. This action opens the Date/Time Properties window, where you can adjust the date, time, and 

time zone. 

5. Once the proper date and time are set, click Apply, and then Ok. 

https://www.computerhope.com/jargon/t/time.htm


Change screen saver in Windows XP 
 

1. Open the Control Panel. 

2. In the Control Panel window, click Appearance and Personalization. 

3. In the Display window, click the Screen Saver tab. 

4. Under the Screen saver section, click the down arrow on the right side of the first box. 

5. Once you have selected your screen saver (or, if you don't want to have a screen saver, 

select none) and adjust any other settings to your liking, click Apply, then click OK. 

 QUESTIONS  

1. Define: operating system. 

2. What is desktop? 

3. Write about the types of user interface. 

4. Write short notes on cut and copy. 

5. What is control panel? Explain. 

6. How to manage files and folders in MS-Windows.  

7. What are the various features of MS-WORD? 

8. Explain Macro? Write down the steps to record a new macro. 

9. Explain the components of windows operating system in detail. 

  

 

  

 

 



UNIT-IV 

MS-WORD 

 INTRODUCTION TO MS-WORD WORKING WITH DOCUMENTS 

 USING TABLES 

 PICTURE AND CHARTS 

 USING MAIL MERGE  

 CREATING FORM LETTERS AND LABELS 

 COLLABORATING WITH WORKGROUPS 

 MODIFYING A REPORT  

 MACROS  

4.1 BASIC USES OF MICROSOFT WORD: – 

You can create, design, and edit letters, resume, bills, reports, applications, forms, 

birthday cards, business cards, calendars, books, articles, assignments in Microsoft 

Word and you can share them with your friends and also in public. And you can 

work with your team members in real-time on the same document. There are pre-

designed templates that you can use to create various kinds of personal and official 

documents. 

4.1.1 THERE ARE THREE METHODS YOU CAN FOLLOW TO USE MICROSOFT 

WORD. 

 

 To create anything such as forms, resume, business cards, applications, and 

bills, etc. you need to visualize first, what kind of document you want to 

create. Such as if you want to create business cards in MS-Word then you 

need to visualize the colours, shapes, text, and alignment, etc. to give it a 

look you’re imagining. Basic knowledge of official documents is important 

to utilize the features of MS-Word. 

 See the samples of existed documents on the Internet and then create similar 

by seeing the sample. Also, you can watch video tutorials on YouTube. So, 

you can learn the basics of this method. But more advanced knowledge of 

Microsoft features and function it’s better than you can join an online course 

if really want to learn quickly. 

 You can also download a template related to your documents such as the 

current account opening application for a bank. After downloading the 



template then replace exists text with your own. Save the document by 

pressing Ctrl+S and Print the document or use Ctrl+P. 

 It’s not that easy for the beginner or basic course student to learn Microsoft 

Word faster. But after 2-3 days of practical classes or by watching online 

videos related to Microsoft word Tutorial you can able to work on Word 

more frequently and with quality. 

4.2 WORK WITH DOCUMENTS 

 Starts you work in Word with these quick instructions how to create, share, 

and edit documents on your own or with your team. 

 To convert your Google Docs to a Word document, go 

to File > Download > Microsoft Word (.docx). Then, open the file in Word. 

See more at get started with Docs. 

Create a document   

1. Select File > Home. 

2. Select Blank document, select one of the templates, or open  a Recommended 

or  Recent file. 



 

 

Open a document 

 Select File > Open, and select the document you want. 

 If your files saved to One Drive and you're working offline, your revisions 

will be saved the next time you connect online. 



 

4.2.1 RENAME A DOCUMENT 

 If your file's saved to OneDrive, select the file name at the top, and type in what 

you  want. 

 Select File > Save As, choose a location to save to, and rename your file. 

 

 

CHOOSE A SAVE OPTION 

.Select File > Save As. 

1. Select One Drive. 



2. Type in a name and select Save. 

Other save options 

There are more ways to save your document. First, select File: 

 To save your file, select Save, or select File > Save. 

 To save your file as a PDF, select File > Save as Adobe PDF. 

4.3 HOW TO MAKE A TABLE ON MICROSOFT WORD 

Tables help you present information in a clear and organized way. There are three ways to 

add tables to your documents in Microsoft Word, each taking only a few easy steps. These 

instructions are based on Microsoft Word 2003, but the process is very similar in other 

versions of Word. Here's how to make a table from the Tables and Borders toolbar: 

 HOW TO MAKE A TABLE ON MICROSOFT WORD 

Tables help you present information in a clear and organized way. There are three ways to 

add     tables to your documents in Microsoft Word, each taking only a few easy steps. 

These instructions are based on Microsoft Word 2003, but the process is very similar in 

other versions of Word. 

Here's how to make a table from the Tables and Borders toolbar: 

Place the cursor where you want to place the table. 

Click the Insert Table icon on the Tables and Borders toolbar at the top of the window. Drag 

the corner of the table until you have the desired number of columns and rows. 

 Click the mouse to insert the table. 

 Here's how to make a table from the Insert Table dialogue box: 

 Click on Table from the menu bar. Select Insert, and then Table… A dialogue box will open. 

 Enter the desired number of rows and columns. 

 Choose AutoFit behaviour if you want the table's cells to automatically expand to fit the text 

inside them. Choose AutoFormat if you'd rather select a table with a specific format. 

 Click OK to insert your table. 

 Here's how to draw a table: 



 Select Table from the menu bar. 

 Select Draw Table. 

 Drag the pencil diagonally across the page to make a rectangle where you want to place your 

table. 

 Draw lines vertically and horizontally to create the columns and rows you need. 

 You can modify your table as follows: 

 Select your table, or a portion of it. 

 Right click your mouse. Choose Table Properties. You can also choose Table Properties from 

the Table menu in the menu bar.  

 Adjust the alignment, as well as the row and column settings. You can also make use of the text 

wrapping feature. Click OK when you've made the desired changes. 

Adjust your table's colours and lines, as follows. 

1. Click the Table tab. 

2. Choose Table Properties. 

3. Click on the Borders and Shading…button. Make the desired selections and 

click OK, and then click OK again. 

 

4.4  HOW TO CREATE A CHART OR GRAPH IN MICROSOFT WORD 

In Microsoft Word, not only can you create documents with text and insert pictures into 

documents, but you can also create a chart or graph to add visual detail to documents.There 

are two options for creating a chart or graph in Microsoft Word. Click a link below for 

details on how to use each option. 

Create chart or graph directly in Microsoft Word 

Like in Microsoft Excel, Microsoft Word provides the capability of creating a chart or 

graph and adding to your document. To create and insert a chart or graph directly in 

Microsoft Word, follow the steps below. 

1. Open the Microsoft Word program. 

2. In the Ribbon bar at the top, click the Insert tab. 

https://www.computerhope.com/jargon/c/chart.htm


3. In the Illustrations section, click the Chart option. 

 

4. Once the Insert Chart window is open, select the type of chart or graph you want to create, 

then click the OK button. 

5. A basic version of the selected chart or graph type, with sample data, is added to the document. 

A Chart in Microsoft Word window also opens, which looks like a Microsoft Excel spreadsheet. 

In the spreadsheet window, add, remove, or modify the columns and rows of data to include 

the data points and values you want your chart to display. 

6. As you modify the columns, rows, and values in the spreadsheet window, the chart or graph in 

Microsoft Word automatically updates and display the new or changed data. 

7. When finished modifying the chart, close the spreadsheet window. 

If you need to update the chart data after closing the spreadsheet window, you can re-

open the spreadsheet window by right-clicking on the chart and selecting the Edit 

Data option. 

 

 

 

 

4.5 CREATE CHART OR GRAPH IN MICROSOFT EXCEL AND COPY TO 

MICROSOFT WORD 

Microsoft Excel provides more functionality and data manipulation capabilities 

than Microsoft Word provides when creating a chart or graph. If you need the increased 

capabilities of Excel to create a chart or graph, and then put it in a Microsoft Word 

document, follow the steps below. 

1. Open the Microsoft Excel and Microsoft Word programs. 

 

2. Create the chart or graph in Microsoft Excel. 



3. After the chart or graph is created and ready to be placed in the Word document, select 

the entire chart in Excel. 

4. Right-click on the chart or graph and select the Copy option. You can also 

press Ctrl+C on your keyboard to copy the chart or graph. 

5. In the Word document, place your mouse cursor where you want to add the chart or 

graph. 

6. Right-click and select the Paste option to place the chart or graph in the document. 

You can also press Ctrl+V on your keyboard to paste the chart or graph. 

4.6 MAIL MERGE  

 

Creating the main document in MS Word 

The next step is to create the form letter template (your main document) in 

MS Word. Here’s a step-by-step guide on how to do this: 

Step 1 

Open a blank document in Word. This is the main document in your mail 

merge that will be sent to each recipient. 

 



Step 2 

Click on the Mailings tab and select Start Mail Merge. 

A drop-down menu displaying every different mail merge document type will appear. 

You can select the document type for letters, emails, envelopes, mailing labels, or a 

directory. 

Since we’re creating a Word mail merge for sending letters, choose Letters as your merge 

document. 

 

 

Step 3 (Optional) 

You can also use the Step-by-Step Mail Merge Wizard (from the Start Mail Merge drop-

down menu) to streamline the Word mail merge process. 

For example, the wizard lets you easily select the starting document for your mail merge. It 

lets you use the current document, a starter template, or an existing document as your mail 

merge template. 



 

Step 4 

Write the body of the letter. (Don’t worry about manually adding placeholders in your 

letter yet.) 

 

 Selecting the recipient list 

Now you can select the list of mail merge recipients who will receive your letter. Here’s a 

step-by-step guide on how to do this: 



Step 1 

Click on the Select Recipients option in the Mailings tab. A drop-down menu appears, 

showing different mail merge list sources. 

As your contact information is already available as an Excel file, click on Use an Existing 

List. 

 

Note – You can also include your Outlook Contacts if you have Outlook connected to 

Word. 

Step 2 

In the dialog box that pops-up, select the Excel sheet you created earlier, and click Open. 



 

Step 3 

A Select Table window appears. Choose the Excel worksheet you want to merge with the 

Word template and click OK. 

 



Note – If your Excel spreadsheet has only one worksheet, you’ll only see Sheet1 in 

the Select Table window. 

Step 4 

If you want to edit your mail merge recipients list, click on the Edit Recipient List tab. 

In the Mail Merge Recipients window that pops-up, clear the checkbox of the person you 

don’t want in your mailing list. 

 

 Adding personalized messages 

The next step is to add personalized content, like contact names and addresses, to your 

form letter template (Word document). 

 

 



In Word, you can insert three personalization variables into your document: 

1. Insert Address Block – add a recipient’s address to your document. 

2. Insert Greeting Line – include a personalized greeting or salutation in your letter. 

3. Insert Merge Field – insert other mail merge fields from your Excel file. 

Here’s a step-by-step guide on how to add all three personalization variables to your merge 

document (form letter): 

Note – You can add a personalization variable at an insertion point of your choice in the 

Word document. For example, to add a greeting line before the body of your letter, simply 

place the text cursor at the point you want to add it. 

Step 1 – Insert address block 

To insert a recipient’s address from your Excel worksheet, click on Address Block from 

the Write & Insert Fields section. In the window that appears, choose an address block 

format of your choice and click OK. 

 

An address placeholder («Address Block») will be inserted automatically into your letter. 



 

Step 2 – Insert greeting line 

To insert a greeting line, click on Greeting Line from the Write & Insert fields section. In 

the dialog box that pops up, select the format you want to use and click OK. 

 

A greeting placeholder («Greeting Line») will be automatically added to your document. 



 

Step 3 – Insert merge field 

You can also add other mail merge fields — like your contact’s first name, company name, 

email id, etc. — from your Excel worksheet to your Word template. To do this, click 

on Insert Merge Field from the Write & Insert fields group. 

You can see a drop-down list of some mail merge labels. These labels are the column 

names in your Excel spreadsheet. 

 

Click on the mail merge fields you want to add to your letter. 

This is how my form letter looks after inserting the placeholders I needed: 



 

4.7 WORKGROUP IN MICROSOFT WORD 

 Workgroup templates are templates set up to be shared by placing them in a 

separate folder. There is no difference in the structure or content of the templates 

themselves, merely in the location they are stored. They are intended to be shared 

by different users of the same computer or on a network. For instance if there are 

form documents used throughout an office, department, household, or business, 

they are best stored as Workgroup Templates. Generally the workgroup templates 

are pre-packaged templates for use by more than one user, often company-wide. 

They can be used by an individual to distinguish work templates from personal 

templates or finished templates from development templates. 

 Personal templates are kept in the User Templates Folder. The default location for 

these is described in Normal Template in Microsoft Word - How to Open. The 

Normal Template is not stored in the Workgroup Templates folder but in the User 

Templates Folder. 

 For more about templates and their location, see Template Basics. 

 The location for Workgroup templates is set in Word's options. It can be any folder 

but should probably be in the User Profile folder rather than in the Documents 

Folder. There is no default. 

  In Word 97-2003 this location is found/set under Tools > Options > File Locat

ions. 



 

 

 
 In Word 2007 this location is found/set under the Office Button > Word Options 

(button) > Advanced > File Locations (button near bottom) 

 

 



 

 

In Word 2010-2016/365 this is found/set under File > Options > Advanced > File Locations (button near 

bottom) 

 



 

 

 When a template is in the Workgroup templates folder it will be available as a 

template in Custom under File New or "on my computer" or in "My Templates" to 

create new documents. If it is in a folder within the Workgroup templates folder, the 

name of that folder will show up as a tab to sort out templates into categories. 

Again, see Template Basics. 

 When workgroup templates are shared on a network, it is often advisable to copy 

them to the local computer as a part of the login process rather than share them 

directly. Otherwise, if a template is being used by any user it cannot be edited by 

support personnel without locating the user and asking them to close their work. 

This also gives laptop users access to the workgroup templates. 



 If the Workgroup Templates location has already been set, once you've clicked on 

the Modify button you can find the actual location. 

 Once you have the Modify dialog open, go up one level to see the folder that holds 

the Workgroup Templates folder. Right-click on the Workgroup Templates folder 

to get its properties. One of those properties is the location. This will probably be a 

longer line than you can read in the properties box. You can select it with your 

mouse, though, and copy it. 

 With that address copied into the Clipboard, close and cancel your way out of the 

Word Options. Do not modify this location without a good reason. 

 Paste the address into the address box in a Windows Explorer window to get to the 

Workgroup Templates folder. 

4.8 MODIFYING A WORD REPORT  

This procedure describes how to modify a Word report layout on report from the Microsoft 

Dynamics NAV Development Environment. A Word report layout determines the content 

and format of a report when it is viewed and printed from the Dynamics NAV client. When 

you modify a Word report layout, you specify the fields of the report dataset to include on 

report and how the fields are arranged. You also define the general format of the report, 

such as text font and size, margins, and background images. You will typically arrange the 

content of the report by adding tables to the layout. 

You insert dataset fields in the layout by using a custom XML part that is automatically 

generated for the report when you create the Word report layout. For more information 

about custom XML parts, see Custom XML Part Overview for Word Report Layouts. 

To modify the Word report layout 

1. In the development environment, export the Word report layout as a Word document 

file to your computer or network. 

For more information see To export a Word report layout from a report to a file. 

2. Open the Word document file in Word 2013 and make changes. 

 To make basic layout changes, such as adding or removing tables and cells, 

formatting text, or changing margins, use the editing features of Word. 

 To add fields from the report dataset to the layout, use the custom XML part 

for the report to add content controls that map to the fields. For more 

information, see How to: Add Fields from a Report Dataset to a Word Report 

Layout. 

   Removing Label and Data Fields 

   Label and data fields of a report are contained in content controls in Word. The following     

figure illustrates a content control when it is selected in the Word document. 



 

The name of the label or data field name displays in the content control. In the example, the 

field name is CompanyAddr1. 

To remove a label or data field 

1. Right-click the field that you want to delete, and then choose Remove Content 

Control. 

2. The content control is removed, but the field name remains as text. 

3. Delete the remaining text as needed. 

4.9.HOW TO CREATE MACROS IN MICROSOFT WORD 
 

A macro is a series of commands that is recorded so it can be played back (executed) at a 

later time. Macros are great for reducing the amount of work you have to do on a series of 

steps that you perform frequently. Here's how to create and test a macro in Microsoft 

Word. Why Use a Macro 

With a macro, you can get the same results by clicking a command instead of going 

through all the steps. Some ways to use macros to increase your productivity include: 

 Insert your company logo and name in a particular typeface. 

 Insert a table that you need to create regularly. 

 Format a document with certain characteristics, such as page numbering and 

double-spaced paragraphs. 

Creating and using macros is a learned skill but the resulting efficiency is well worth the 

effort. 

 4.9. 1Macro 

 

Table. To do this, we click on “View,” then “Macros,” then “Record Macro.” 

When using Microsoft Word, you may feel the need to repeat a specific action multiple 

times. This may involve reusing preset text or inserting specific text with intricate 

formatting. It can be a chore, and you may be wishing for an easier way to do it. 

https://www.lifewire.com/insert-a-table-in-microsoft-word-3540349


Thankfully, there is one! By making use of Word’s macros, you can automate repetitive 

actions and make your life simpler. 

What Are Macros? 

So, what are macros? The best way to think of macros is as a series of instructions. You set 

out a series of steps that you want Word to automate, then tell Word to perform those steps 

whenever you like. This makes automation very easy, and can save a lot of time and effort. 

The easiest way to create a macro is to allow Word to record your actions, then physically 

perform your desired actions within the document. Once recorded, you can tell Word to 

repeat what you did at any time. 

4.9.1 Making a Macro 

 

So now that we know what they do, let’s learn to make a macro in Microsoft Word! In this 

example we’ll be creating a macro that automatically creates a table. This might be a useful 

feature if you occasionally see yourself needing to create a new table without manually 

making a new one or copy-pasting an existing table. 

First, we need to tell Microsoft Word how to make our

 

We name our macro here. For this example we’ll call it “Create Table.” 



 

Underneath the naming box are two buttons, “Button” and “Keyboard.” This is 

where you pick if you want to activate your macro via a button within Word or 

by pressing a hotkey on your keyboard. 

Selecting the Button Option 

If you select “Button,” you’ll be taken to a new popup window. It may look 

confusing at first, but it’s just Word allowing you to add the button to the Quick 

Access bar. This is where we want our button, so we’ll select the macro and click 

“Add >>” to add it to the list on the right. 

 

With the macro still selected, click “Modify…” at the bottom of the list. 



 

Here you can choose what icon your button uses. Pick something that suits your 

macro, then OK out of all windows. 

 

Selecting the Keyboard Option 

If you select the keyboard option, you can define which hotkey to assign the 

macro to. It’s compatible with quite a few combinations, such 

as Ctrl  + [Key]  and Ctrl  + Shift  + [Key] , so pick out a hotkey that suits you. 

Word will let you know if anything is currently assigned to that hotkey so you 

don’t interfere with existing shortcuts. Once you’ve found the perfect key 

combination, click “Assign.” 



4.10 RECORDING THE MACRO 

Now that you have set up the method of activation, Microsoft Word will begin 

recording your actions. While it’s recording, any actions you now perform in the 

document will be remembered in the macro. In this example, we create our table 

and fill it out with the essential fields. Because our actions are being recorded, 

we should be careful and not make any mistakes! 

 

Once the table is done, we click “View,” then “Macro” again, and then click 

“Stop recording.” 

 

Now that our macro is recorded, we can make this table at any time we like. If 

we assigned it to a hotkey on the keyboard, we can press those keys to insert a 

table. Likewise, if we made a button for it, we can find that button in the Quick 

Access bar. 

 



Regardless of which method we selected for the macro, our table is replicated 

when we activate it. Now we can recreate our base table with little hassle! 

 

Deleting a Macro 
 

When your macro has outlived its use, you can get rid of them by simply clicking 

“View,” then “Macros,” then “View Macros.” 

 

Select the macro you don’t want anymore, then click “Delete.” 



 

 



UNIT-V 

MS-POWER POINT  

 CREATING A PRESENTATION 

 CREATING AND PUBLISHING A WEB PRESENTATION 

 MODIFYING A PRESENTATION  

 WORKING WITH VISUAL ELEMENTS  

 PRESENTATION AND DESIGNING A TEMPLATE 

5.1  MORE CREATIVE SLIDESHOWS  

 I like to think of Microsoft PowerPoint as a test of basic marketing skills. To 

create a passing presentation, I need to demonstrate design skills, technical 

literacy, and a sense of personal style. 

 If the presentation has a problem (like an unintended font, a broken link, or 

unreadable text), then I’ve probably failed the test. 

 Even if my spoken presentation is well rehearsed, a bad visual experience can 

ruin it for the audience. 

 Expertise means nothing without a good presentation to back it up. For starters, 

grab your collection of free PowerPoint templates below, and use the tips that 

follow to perfect your next presentation. 

 No matter your topic, successful PowerPoints depend on three main factors: 

your command of PowerPoint's design tools, your attention to presentation 

processes, and your devotion to consistent style. Here are some simple tips to 

help you start mastering each of those factors, and don't forget to check out the 

additional resources at the bottom of this post. 

 

Make a Power Point Slide 

 Open Microsoft PowerPoint. 

 If a page with templates doesn't automatically open, go to "File" at the top left 

of your screen and click "New Presentation". 

 To use a template, either click the "Design" tab or go to "File" again and click 

"New from Template". 

 Insert a new slide by clicking on the "Home" tab and then the "New Slide" 

button. 



 Consider what content you want to put on the slide, including heading, text, and 

imagery. 

 Keep the amount of text under 6-8 lines (or 30 words) at a minimum of size 24 

pt. 

 Add images by clicking "Insert" and clicking the "Picture" icon. 

 Add other elements by using features in the "Home" and "Insert" tabs on the top 

ribbon. 

 Play around with the layout by dragging elements around with your mouse. 

How to Make a PowerPoint Presentation 

 A presentation is made up of multiple slides, and now that you know how to 

make one, you can delve deeper into PowerPoint's capabilities. 

 Open a blank presentation again or start from one you've already created. 

 If you've already created a presentation, double click the icon to open the 

existing file. Otherwise, open Microsoft PowerPoint, click "File" in the top left 

corner, and click "New Presentation." From there, you can follow the prompts to 

set up a new presentation. 

5.2. CHOOSE A "THEME" OR CREATE YOUR OWN. 

Microsoft offers built-in themes and colour variations to help you design your slides with a 

cohesive look. To choose from these pre-built themes, choose the "File" tab again, select "New", 

choose one of the options, and click "Create." 

Otherwise, you can use PowerPoint elements, your design sense, and your brand's colour palette 

to make your own "theme." 

5.3. CREATE A VARIETY OF SLIDES FOR DIFFERENT PURPOSES. 

You don't want to present the same exact slide, just with different content on it. This would bore 

your audience. Ensure that you create multiple variations, accommodating some of the common 

uses for slides. At minimum, you'll need: 

 A title slide 

 An agenda or table of contents slide 

 A slide that introduces the speaker 



 Various content slides (create different layouts considering what kind of 

multimedia you'll use) 

5.4. USE THE DUPLICATE SLIDES FEATURE TO SAVE YOU TIME. 

There's no reason to create these designs over and over again. Now that you have a few to draw 

from, you can simply duplicate them before inputting your content. Here's how to do that: 

1. On the left pane, right click the thumbnail of the slide you want to duplicate. 

2. Choose "Duplicate Slide" from the pop-up menu. 

This will automatically add a copy of this slide to the presentation. From there, you can 

customize it for your needs. 

5.5. ADD TRANSITIONS TO YOUR SLIDES (OPTIONAL). 

Done well, transitions can add a little bit of movement and showmanship to your presentation. 

PowerPoint has several transitions built in for you to choose from. 

To access them, select the "Transitions" tab from the top ribbon. From there, you can select a 

transition for it to preview on your screen. To customize it further, click "Effect Options" and 

play with the features to find something that suits your liking. To remove a transition, select 

"Transitions" and click "None." 

5.6. ADD ANIMATIONS TO YOUR SLIDES (OPTIONAL). 

Like transitions, animations can add movement, reveal information, and help you underscore the 

points you want to hit during your speech. To animate an element, follow these steps: 

1. Select the element you want animated by clicking on it. 

2. Choose "Animations" from the top ribbon. 

3. You'll have the option to choose from several effects displayed in the ribbon. 

4. Clicking on one will give you a preview. 

5. To customize the animation, select "Effect Options." 



6. To remove an animation, click "None" in the ribbon. 

Some of the ways to customize animations include: 

 On Click 

 With Previous 

 After Previous 

 Duration 

 Delay 

These describe how you want the effect to behave, so play around with them until you find an 

effect that suits your liking.You'll also have the option to move animations around as you edit 

your slides with the "Reorder Animation" function in the top ribbon. 

5.7. SAVE YOUR PRESENTATION. 

Click "File" and "Save", making sure to specify which folder or destination you want your 

PowerPoint to be stored. 

5.8. RUN YOUR PRESENTATION. 

It's always good to do a trial run to ensure that your slides are set up properly and your 

animations fire they way you expect them to. 

To present your PowerPoint, go to the "Slide Show" tab and click "Play from Start". The slide 

will cover your whole screen, blocking out your desktop and PowerPoint software. This is so 

your audience (in this case, you for the trial run) is solely focused on the visual elements of your 

presentation. 

5.9. ADVANCE THE SLIDES. 

When you're done with one slide and want to show the next in your sequence, click your mouse 

in presentation mode. This will advance the slide. 

PowerPoint Presentation User Guide 

1. Don't let PowerPoint decide how you use PowerPoint. 



2. Create custom slide sizes. 

3. Edit your slide template design. 

4. Write text with your audience in mind. 

5. Make sure all of your objects are properly aligned. 

6. Use "Format Menus" to better control your objects' designs. 

7. Take advantage of PowerPoint's shapes. 

8. Create custom shapes. 

9. Crop images into custom shapes. 

10. Present websites within PowerPoint. 

11. Try Using GIFs. 

12. Keep it simple. 

13. Embed your font files. 

14. Save your slides as JPEGs. 

15. Embed multimedia.  

16. Bring your own hardware. 

17. Use "Presenter View." 

5.10  POWERPOINT STYLE 

1.how to use PowerPoint. 

Microsoft wanted to provide PowerPoint users with a lot of tools. But this does not mean you 

should use them all. Here are some key things to look out for: 

 Make sure that preset PPT themes complement your needs before you adopt 

them. 



 Try to get away from using Microsoft Office’s default fonts, Calibri and 

Cambria. Using these two typefaces can make the presentation seem 

underwhelming. 

 Professionals should never use PPT’s action sounds. (Please consider your 

audience above personal preference). 

 PowerPoint makes bulleting automatic, but ask yourself: Are bullets actually 

appropriate for what you need to do? Sometimes they are, but not always. 

 Recent PPT defaults include a small shadow on all shapes. Remove this 

shadow if it's not actually needed. Also, don’t leave shapes in their default 

blue. 

2. Create custom slide sizes. 

While you usually can get away with the default slide size for most presentations, you 

may need to adjust it for larger presentations on weirdly sized displays. If you need to 

do that, here's how. 

 In the top-left corner, choose "File." 

 Select "Page Setup." 

 Type the height and width of the background you'd like, and click "OK." 

 A dialogue box will appear. Click "OK" again. 

 Your background is resized! 



 

3. Edit your slide template design. 

Often, it's much easier to edit your PowerPoint template before you start -- this way, you don't 

have design each slide by hand. Here's how you do that. 

 Select "Themes" in the top navigation. 

 In the far right, click "Edit Master," then "Slide Master." 

 Make any changes you like, then click "Close Master." All current and future 

slides in that presentation will use that template. 
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